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Notices
ASUS Recycling/Takeback Services

ASUS recycling and takeback programs come from our commitment to the highest standards
for protecting our environment. We believe in providing solutions for you to be able to
responsibly recycle our products, batteries, other components, as well as the packaging
materials. Please go to http://csr.asus.com/english/Takeback.htm for the detailed recycling
information in different regions.

REACH

Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of
Chemicals) regulatory framework, we published the chemical substances in our products at
ASUS REACH website at http://cst.asus.com/english/REACH.htm

Federal Communications Commission Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

+  This device may not cause harmful interference; and

+  This device must accept any interference received including interference that may cause
undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed

and used in accordance with manufacturer’s instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur

in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

+  Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+  Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

+  Consult the dealer or an experienced radio/TV technician for help.

R The use of shielded cables for connection of the monitor to the graphics card is required
to assure compliance with FCC regulations. Changes or modifications to this unit not
expressly approved by the party responsible for compliance could void the user’s authority
to operate this equipment.




RF exposure warning

This equipment must be installed and operated in accordance with provided instructions and
the antenna(s) used for this transmitter must be installed to provide a separation distance of
at least 20 cm from all persons and must not be co-located or operating in conjunction with
any other antenna or transmitter. End-users and installers must be provide with antenna
installation instructions and transmitter operating conditions for satisfying RF exposure
compliance.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of
Communications.

This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice

This product incorporates copyright protection technology that is protected by method

claims of certain U.S. patents and other intellectual property rights owned by Macrovision
Corporation and other rights owners. Use of this copyright protection technology must be
authorized by Macrovision Corporation, and is intended for home and other limited viewing
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering
or disassembly is prohibited.

Lithium-lon Battery Warning

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.




Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent
and a few drops of warm water then remove any extra moisture with a dry cloth.

+ DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has
been damaged.

+ DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.

+ DO NOT place or drop objects on top and do not shove any foreign objects into the
Desktop PC.

+ DO NOT expose to strong magnetic or electrical fields.

+ DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during
electrical storms.

+  Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the
contacts. DO NOT disassemble the battery.

+ Use this product in environments with ambient temperatures between 0°C (32°F)and
35°C (95°F).

+ DO NOT cover the vents on the Desktop PC to prevent the system from getting
overheated.

+ DO NOT use damaged power cords, accessories, or other peripherals.

- To prevent electrical shock hazard, disconnect the power cable from the electrical outlet
before relocating the system.

+  Seek professional assistance before using an adapter or extension cord. These devices
could interrupt the grounding circuit.

- Ensure that your power supply is set to the correct voltage in your area. If you are not
sure about the voltage of the electrical outlet you are using, contact your local power
company.

+ Ifthe power supply is broken, do not try to fix it by yourself. Contact a qualified service
technician or your retailer.



Conventions used in this guide

To ensure that you perform certain tasks properly, take note of the following symbols used
throughout this manual.

i DANGER/WARNING: Information to prevent injury to yourself
‘7 when trying to complete a task.

CAUTION: Information to prevent damage to the components
when trying to complete a task.

IMPORTANT: Instructions that you MUST follow to complete a
task.

NOTE: Tips and additional information to help you complete a
task.

N 9

Where to find more information
Refer to the following sources for additional information and for product and software
updates.

ASUS websites

The ASUS website provides updated information on ASUS hardware and software
products. Refer to the ASUS website www.asus.com.

ASUS Local Technical Support

Visit ASUS website at http://support.asus.com/contact for the contact information of
local Technical Support Engineer.


http://www.asus.com
http://support.asus.com/contact

Package contents

===
= Ve
ASUS Essentio Desktop PC Keyboard x1
Mouse x1 Power cord x1 Nero 9 burning software
DVD/SDVD/RDVD x1
(optional)
\nsteletion Sude: ‘3‘\\\3
=
=
Installation Guide x1 Warranty card x1 Antenna x1 (optional)
% + If any of the above items is damaged or missing, contact your retailer.

+ Theillustrated items above are for reference only. Actual product specifications may vary
with different models.






Getting started

Welcome!

Thank you for purchasing the ASUS Essentio CM6870 Desktop PC!

The ASUS Essentio CM6870 Desktop PC provides cutting-edge performance,
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a
stunningly futuristic and stylish system casing.

R Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

Getting to know your computer

% lllustrations are for reference only. The ports and their locations, and the chassis color vary
L with different models.

Front panel

T BT

expansion BaY
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1. USB 3.0 ports. These Universal Serial Bus 3.0 (USB 3.0) ports connect to USB 3.0
devices such as a mouse, printer, scanner, camera, PDA, and others.
2.  USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.
3. Microphone port (pink). This port connects to a microphone.
4.  Headphone port (lime). This port connects to a headphone or speaker.
5. Power button. Press this button to turn on your computer.
6.  Optical disk drive eject button. Press this button to eject the optical disk drive tray.
7.  Optical disk drive bay (empty). Allows you to install an additional optical disk drive in
this bay.
8.  Optical disk drive bay. There is an optical disk drive in this bay.
9.  Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory
Stick Pro™ card into this slot.
10. Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ / MultiMediaCard
card into this slot.
11. CompactFlash®/ Microdrive™ card slot. Insert a CompactFlash® / Microdrive™ card
into this slot.
Rear panel
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1. Power connector. Plug the power cord to this connector.

/ RATING: 115Vac/220-230Vac, 7A/4A. 60/50Hz.

2. Power switch. Switch to turn ON/OFF the power supply to your computer.

3. USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

4. HDMI port. This port is for a High-Definition Multimedia Interface (HDMI) connector,
and is HDCP compliant allowing playback of HD DVD, Blu-ray, and other protected
content.

5. DVI-D port. This port is for any DVI-D compatible device and is HDCP compliant
allowing playback of HD DVD, Blu-ray, and other protected content.

6.  USB 3.0 ports. These Universal Serial Bus 3.0 (USB 3.0) ports connect to USB 3.0
devices such as a mouse, printer, scanner, camera, PDA, and others.

% + DO NOT connect a keyboard / mouse to any USB 3.0 port when installing Windows®
8 operating system.

Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under Windows®
OS environment and after the USB 3.0 driver installation.

+ USB 3.0 devices can only be used as data storage only.

+ We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster
and better performance for your USB 3.0 devices.

7.  Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel
audio configuration.

8.  Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and
8-channel audio configuration.

9.  Center/Subwoofer port (orange). This port connects to the center/subwoofer
speakers.

10. Microphone port (pink). This port connects to a microphone.

11.  Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or
8-channel configuration, the function of this port becomes Front Speaker Out.

12. Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio
sources.

% Refer to the audio configuration table on the next page for the function of the audio ports in
- a2, 4, 6, or 8-channel configuration.

ASUS CM6870 13



Audio 2, 4, 6, or 8-channel configuration

Headset

2-channel 4-channel 6-channel 8-channel
Light Blue Line In Line In Line In Line In
Lime I Line Out I Front Speaker Out I Front Speaker Out I Front Speaker Out
Pk | Miem | Mic In | Mic In | Mic In
Orange I - I - I Center/Subwoofer I Center/Subwoofer
Black I - I Rear Speaker Out I Rear Speaker Out I Rear Speaker Out
Gray I - I - I - I Side Speaker Out

13. Expansion slot bracket. Remove the expansion slot bracket when installing an
expansion card.

14. ASUS WLAN Card (on selected models only). This optional WLAN card allows your
computer to connect to a wireless network.

15. ASUS Graphics Card (on selected models only). The display output ports on this
optional ASUS Graphics Card may vary with different models.

16. LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN)
through a network hub.

LAN port LED indications

ACT/LINK SPEED
LED LED
i
= -
OFF No link OFF 10Mbps connection -
ORANGE Linked ORANGE 100Mbps connection
BLINKING Data activity GREEN 1Gbps connection LAN port

17.  VGA port. This port is for VGA-compatible devices such as a VGA monitor.

18. PS/2 Keyboard / Mouse Combo port (purple). This port is for a PS/2 keyboard or
mouse.

19. Air vents. These vents allow air ventilation.

/ \ DO NOT block the air vents on the chassis. Always provide proper ventilation for your
—= computer.
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Setting up your computer

This section guides you through connecting the main hardware devices, such as the external
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor

Using the ASUS Graphics Card (on selected models only)
Connect your monitor to the display output port on the discrete ASUS Graphics Card.

To connect an external monitor using the ASUS Graphics Card:

1. Connect a monitor to a display output port on the ASUS Graphics Card.
2. Plug the monitor to a power source.

/ The display output ports on the ASUS Graphics Card may vary with different models.

ASUS CM6870 15



Using the onboard display output ports
Connect your monitor to the onboard display output port.

To connect an external monitor using the onboard display output ports:

1.

Connect a VGA monitor to the VGA port, or a DVI-D monitor to the DVI-D port, or an
HDMI monitor to the HDMI port on the rear panel of your computer.

Plug the monitor to a power source.

gy

If your computer comes with an ASUS Graphics Card, the graphics card is set as the
primary display device in the BIOS. Hence, connect your monitor to a display output port
on the graphics card.

+ To connect multiple external monitors to your computer, refer to Connecting multiple

external monitors in Chapter 3 of this user manual for details.

Chapter 1: Getting started



Connecting a USB keyboard and a USB mouse

Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your
computer.
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/ Connect your USB keyboard and USB mouse to the USB 2.0 ports.

Connecting the power cord

Connect one end of the power cord to the power connector on the rear panel of your
computer and the other end to a power source.

ASUS CM6870



Turning your computer ON/OFF

This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:

1. Turn on the power switch.
2. Turn your monitor ON.

3. Press the power button on your computer.

Power button

—

4. Wait until the operating system loads automatically.

Turning your computer OFF
To turn your computer OFF:

1. Close all running applications.

2. Click &2 on the Windows® desktop.

3. Click [m to shut down the operating system.

Chapter 1: Getting started



Using Windows® 7

Starting for the first time

When you start your computer for the first time, a series of screens appear to guide you in
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1. Turn your computer on. Wait for a few minutes until the Set Up Windows screen
appears.

From dropdown list, select your language, then click Next.

From the dropdown lists, select your Country or region, Time and currency, and
Keyboard layout, then click Next.

4. Key in uniques names for the user name and computer name, then click Next.

5. Key in the necessary information to set up your password, then click Next. You may
also click Next to skip this step without entering any information.

ﬁ If you want to set up a password for your account later, refer to the section Setting up a
user account and password in this chapter.

6.  Carefully read the license terms. Tick | accept the license terms and click Next.

7.  Select Use recommended settings or Install important updates only to set up the
security settings for your computer. To skip this step, select Ask me later.

8. Review your date and time settings. Click Next. The system loads the new settings and
restarts. You may now start using your computer.

ASUS CM6870 19




Using Windows® 7 desktop

% Click the Start icon > Help and Support to obtain more information about Windows® 7.

Using the Start menu

The Start menu gives you access to programs, utilities, and other useful items on your
computer. It also provides you with more information about Windows 7 through its Help and
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1. From the Windows® taskbar, click the Start icon &,
2. From the Start menu, select the item that you want to launch.

% You may pin programs that you want constantly displayed on the Start menu. For more
- details, refer to the section Pinning programs on the Start menu or taskbar on this
chapter.

Using the Getting Started item

The Getting Started item on the Start menu contains information about some basic tasks
such as personalizing Windows®, adding new users, and transferring files to help you to
familiarize yourself with using Windows® 7.

To use the Getting Started item:

e
1. From the Windows® taskbar, click the Start icon to launch the Start menu.
2. Select Getting Started. The list of available tasks appears.
3. Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

. From the Windows® taskbar, click an icon to launch it. Click the icon again to hide the
program.

You may pin programs that you want constantly displayed on the taskbar. For more details,
refer to the section Pinning programs on the Start menu or taskbar on this chapter.

20 Chapter 2: Using Windows® 7



Pinning items on the jumplists

When you right-click an icon on the taskbar, a jumplist launches to provide you with quick-
access to the program’s or item’s related links.You may pin items on the jumplist such as
favorite websites, often-visited folders or drives, or recently played media files.

To pin items to the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to pin, then select Pin to this list.
Unpinning items from the jumplist

To unpin items from the jumplist:

1. From the taskbar, right-click an icon.

2. From the jumplist, right-click the item that you want to remove from the jumplist, then
select Unpin from this list.

Pinning programs on the Start menu or taskbar
To pin programs on the Start menu or taskbar:
1. From the Windows® taskbar, click the Start icon to launch the Start menu.

2. Right-click the item that you want to pin on the Start menu or taskbar.
3. Select Pin to Taskbar or Pin to Start menu.

% You may also right-click on the icon of a running program on the taskbar, then select Pin
- this program to taskbar.

Unpinning programs from the Start menu
To unpin programs from the Start menu:

1. From the Windows® taskbar, click the Start icon © to launch the Start menu.

2. From the Start menu, right-click the program that you want to unpin, then select
Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar:

1. From the taskbar, right-click the program that you want to remove from the taskbar,
then select Unpin this program from taskbar.

ASUS CM6870 21



Using the notification area
By default, the notification area shows these three icons:

Action Center notification

E Click this icon to display all the alert messages/notifications and launch the Windows®
Action Center.

Network connection

- This icon displays the connection status and signal strength of the wired or wireless network
connection.

Volume
i)

Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

. Click the Notification icon E then click the message to open it.

/ For more details, refer to the section Using Windows® Action Center in this chapter.

Customizing icons and notifications

You may choose to display or hide the icons and notifications on the taskbar or on the
notification area.

To customize icons and notifications:

1. From the notification area, click on the arrow icon '
2. Click Customize.

3. From the dropdown list, select the behaviors for the icons or items that you want to
customize.

Managing your files and folders

Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1. From the Windows® taskbar, click the Start icon © to launch the Start menu.

2. Click Computer to launch Windows Explorer.

22 Chapter 2: Using Windows® 7



Exploring files and folders

To explore files and folders:

1. Launch Windows® Explorer.

2. From the navigation or view pane, browse for the location of your data.

3. From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

Customizing the file/folder view

To customize the file/folder view:

1. Launch Windows Explorer.

2 From the navigation pane, select the location of your data.
3. From the toolbar, click the View icon &= .
4

From the View menu, move the slider to select how you want to view the file/folder.

/ You may also right-click anywhere on the View pane, click View, and select the view type
L that you want.

Arranging your files

To arrange your files:

1. Launch Windows Explorer.

2. From the Arrange by field, click to display the dropdown list.

3. Select your preferred arrangement type.

Sorting your files

To sort your files:

1. Launch Windows Explorer.

2. Right-click anywhere on the View pane.

3. From the menu that appears, select Sort by, then select your preferred sorting type.

Grouping your files
To group your files:
1. Launch Windows Explorer.
Right-click anywhere on the View pane.

From the menu that appears, select Group by, then select your preferred grouping
type.

ASUS CM6870
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Adding a new folder

To add a new folder:

1. Launch Windows Explorer.

2. From the toolbar, click New folder.
3. Key in a name for the new folder.

% You may also right-click anywhere on the View pane, click New > Folder.

Backing up your files

Setting up a backup
To set up a backup:

1. Click ¥ > All Programs > Maintenance > Backup and Restore.
Click Set up backup. Click Next.

2
3. Select your backup destination. Click Next.
4

Select Let Windows choose (recommended) or Let me choose as your backup
mode.

/ If you select Let Windows choose, Windows will not back up your programs, FAT-
- formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5. Follow the onscreen instructions to finish the process.

Restoring your system settings

The Windows® System Restore feature creates a restore point where the computer’s system
settings are stored at certain time and date. It allows you to restore or undo changes to your
computer’s system settings without affecting your personal data.

To restore your system:

1. Close all running applications.

2. Click &= > All Programs > Accessories > System Tools > System Restore.

3. Follow the onscreen instructions to complete the process.

Chapter 2: Using Windows® 7



Protecting your computer

Using Windows® 7 Action Center

Windows® 7 Action Center provides you with alert notifications, security information, system
maintenance information, and the option to automatically troubleshoot and fix some common
computer problems.

/ You may customize the notifications. For more details, refer to the previous section
L Customizing icons and notifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1. To launch Windows 7 Action Center, click the Notification icon m, then click Open
Action Center.

2. From Windows 7 Action Center, click the task that you want to do.

Using Windows® Update

Windows Update allows you to check and install the latest updates to enhance the security
and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1. From the Windows® taskbar, click the Start icon to launch the Start menu.
2. Select All Programs > Windows Update.
3. From the Windows Update screen, click the task that you want to do.

Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

From the Windows® taskbar, click ¥ > Getting Started > Add new users.
Select Manage another account.

Select Create a new account.

Key in the name of the new user.

Select either Standard user or Administrator as the user type.

[ e o

When done, click Create Account.

ASUS CM6870
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Setting up a user’s password
To set up a user’s password:

1. Select the user that you would like to set a password.
Select Create a password.

2
3. Keyinapassword and confirm it. Key in your password’s hint.
4 When done, click Create password.

Activating the anti-virus software
Trend Micro Internet Security is pre-installed on your computer. It is a third-party anti-virus

software protecting your computer from virus. It is purchased separately. You have a 30-day
trial period after activating it.
To activate Trend Micro Internet Security:

1. Run the Trend Micro Internet Security application.

2 Carefully read the license terms. Click Agree & Activate.

3. Input your e-mail address and select your location. Click Next.
4 Click Finish to complete the activation.

Getting Windows® Help and Support
Windows® Help and Support provides you with guides and answers in using the applications
in Windows® 7 platform.

To launch Windows® Help and Support, click ¥ > Help and Support.

% Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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Connecting devices to your computer

Connecting a USB storage device

This desktop PC provides USB 2.0/1.1/3.0 ports on both the front and rear panels. The USB
ports allow you to connect USB devices such as storage devices.

To connect a USB storage device:

+  Insert the USB storage device to your computer.

<
IS i S
)

o
i 35

BRI

Front panel Rear panel

% You can connect your USB storage devices to the USB 3.0 ports.

To remove a USB storage device:

1. Click "} from the Windows notification area on your
computer, then click Eject USB2.0 FlashDisk.

@5 Open Devices and Printers

Eject USB2.0 FlashDisk

- Removable Disk (F:)

6120 FIV
1/1/2002 | |

S g ) o

2. When the Safe to Remove Hardware message | @ safe To Remove Hardware ax
pops up, remove the USB storage device from T LD M f;:v:g;g;v:e‘ device can now be safely
your computer.

/ gi DO NOT remove a USB storage device when data transfer is in progress. Doing so may

L cause data loss or damage the USB storage device.
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Connecting microphone and speakers

This desktop PC comes with microphone ports and speaker ports on both the front and
rear panels. The audio /O ports located on the rear panel allow you to connect 2-channel,
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

U

Connecting 2-channel Speakers

@)

AUDIO
INPUTS
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Connecting 4-channel Speakers

AUDIO AUDIO
INPUTS INPUTS

o 4

Connecting 6-channel Speakers

AUDIO AUDIO AUDIO
INPUTS INPUTS INPUTS
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Connecting 8-channel Speakers

©®®®
N miy
@
o %
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Connecting multiple external displays
Your desktop PC may come with VGA, HDMI, or DVI ports and allows you to connect multiple
external displays.

R When a graphics card is installed in your computer, connect the monitors on the output
ports of the graphics card.

Setting up multiple displays

When using multiple monitors, you are allowed to set display modes. You can use the
additional monitor as a duplicate of your main display, or as an extension to enlarge your
Windows desktop.

To set up multiple displays:

1. Turn off your computer.

2. Connect the two monitors to your computer and connect the power cords to the
monitors. Refer to Setting up your computer section in Chapter 1 for details on how
to connect a monitor to your computer.

%/F For some graphic cards, only the monitor that is set to be the primary display has display
during POST. The dual display function works only under Windows.
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Turn on your computer.

4. Do any of the following to open the Screen Resolution setting screen:

+  Click E > Control Panel > Appearance and Personalization > Display >
Change display settings.

+  Right click anywhere on your Windows desktop. When the pop-up menu appears,
click Personalize > Display > Change display settings.

5. Select the display mode from the Multiple displays: drop-down list.

+  Duplicate these displays: Select this option to use the additional monitor as a
duplicate of your main display.

+  Extend these displays: Select this option to use the additional monitor as an
extension display. This increases your desktop space.

+  Show desktop only on 1/2: Select this option to show desktop only on monitor
1 or monitor 2.

+  Remove this display: Select this options to remove the selected display.

Change the appearance of your displays

—"
Orientation:
Mutiple displays:

Thi

Duplicate these displays
s cumenty o ST Aidvoncedsetfings
Show desktop only on 1
Make text and other Show desktap only an 2
Remove this display.

I What display settings should T choose?

paly

6.  Click Apply or OK. Then click Keep Changes on the confirmation message.

B .

Mdchten Sie diese Anzeigeeinstellungen
beibehalten?

[ Anderungen beibehalten | [ Wiederherstellen |

In 13 Sekunden auf vorherige Anzeigeeinstellungen
|| zurOcksetzen
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer.

/ + You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is
purchased separately.

+ To get the best display performance, ensure that your HDMI cable is less than 15
meters.

33
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Using your computer

Proper posture when using your Desktop PC

When using your Desktop PC, maintaining the proper posture is necessary to prevent strain
to your wrists, hands, and other joints or muscles. This section provides you with tips on
avoiding physical discomfort and possible injury while using and fully enjoying your Desktop

Eye level to the top of
the monitor screen
<

Foot rest 90" angles

To maintain the proper posture:

Position your computer chair to make sure that your elbows are at or slightly above the
keyboard to get a comfortable typing position.

. Adjust the height of your chair to make sure that your knees are slightly higher than
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level
of your knees.

Adjust the back of your chair so that the base of your spine is firmly supported and
angled slightly backward.

Sit upright with your knees, elbows and hips at an approximately 90° angle when you
are at the PC.

Place the monitor directly in front of you, and turn the top of the monitor screen even
with your eye level so that your eyes look slightly downward.

. Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to
reduce the pressure on your wrists while typing.

. Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare
such as windows and straight sunlight.

Take regular mini-breaks from using your Desktop PC.
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Using the memory card reader

Digital cameras and other digital imaging devices use memory cards to store digital picture or
media files. The built-in memory card reader on the front panel of your system allows you to
read from and write to different memory card drives.

To use the memory card:

1. Insert the memory card into the card slot.
% + Amemory card is keyed so that it fits in only one direction. DO NOT force a card into a
/- slot to avoid damaging the card.

You can place media in one or more of the card slots and use each media
independently. Place only one memory card in a slot at one time.

2. Select a program from the AutoPlay window to access your files.

/ + If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the
- taskbar, click Computer, and then double-click the memory card icon to access the data
on it.

Each card slot has its own drive icon which is displayed on the Computer screen.

The memory card reader LED lights up and blinks when data is being read from or
written to the memory card.

3. When finished, right-click the memory card drive icon on the Computer screen, click
Eject, and then remove the card.

R Never remove cards while or immediately after reading, copying, formatting, or deleting
data on the card or else data loss may occur.

To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows
notification area before removing the memory card.

36 Chapter 4: Using your computer



Using the optical drive

Inserting an optical disc
To insert an optical disc:

1. While your system is on, press the eject button below the drive bay cover to open the
tray.

2. Place the disc to the optical drive with the label side facing up.
Push the tray to close it.

Select a program from the AutoPlay window to access your files.

% If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar,
click Computer, and then double-click the CD/DVD drive icon to access the data on it.

Removing an optical disc
To remove an optical disc:

1. While the system is on, do either of the following to eject the tray:
+  Press the eject button below the drive bay cover.
+  Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

2. Remove the disc from the disc tray.
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Using the multimedia keyboard
(on selected models only)

/ The keyboard varies with models. The illustrations on this section are for reference only.

ASUS PRIMAX/KB2621 keyboard

Decreases the system volume.

Turns the volume’s mute mode on/off.

3. Bl |Increases the system volume.

s BB Goes to the previous track in a media

player.
5 [ Plays or pauses playback in a media
player.
Goes to the next track in a media
c. Il player.
% The special function keys only work on Windows® Vista / Windows® 7 operating systems.
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ASUS KB34211 modern wired keyboard

Description

Turns the volume’s mute mode on/off.

o E Decreases the system volume.
5 E Increases the system volume.
% The special function keys only work on Windows® Vista / Windows® 7 / XP operating

- systems.
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Connecting to the Internet

Wired connection

Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network
(LAN).

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1. Set up your DSL/cable modem.

ﬁ Refer to the documentation that came with your DSL/cable modem.

2. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to a DSL/cable modem.

3. Turn on the DSL/cable modem and your computer.

4. Configure the necessary Internet connection settings.

/ Contact your Internet Service Provider (ISP) for details or assistance in setting up your
- Internet connection.
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Connecting via a local area network (LAN)
To connect via a LAN:

1. Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your
computer and the other end to your LAN.

2. Turn on your computer.

3. Configure the necessary Internet connection settings.

% Contact your network administrator for details or assistance in setting up your Internet
connection.
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Wireless connection (on selected models only)

Connect your computer to the Internet through a wireless connection.

R To establish a wireless connection, you need to connect to a wireless access point (AP).

Wireless AP

% + To increase the range and sensitivity of the wireless radio signal, connect the external
antennas to the antenna connectors on the ASUS WLAN Card.

Place the antennas on the top of your computer for the best wireless performance.

+ The external antennas are optional items.

ASUS CM6870 43



44

To connect to a wireless network:

1. Click the network icon n in the notification area to display the available wireless

networks.

-
Not connected s
dﬂﬂ Connections are available
Wireless Network Connection ~
WL-530gV2 M
Asus-WIFE o
As Office ol
$5D-10 .
DAOQ "
$5D-130 il

Open Netwerk and Sharing Center

2. Select the wireless network that you want to connect to, then click Connect.

Not connected 4 |*
dﬂﬂ Connections are available
Wireless Network Connection w
WL-530gV2 \
Connect automatically "
Asus-WIFI E
As Office )
DbAOQ wll
$5D-10 o
Ala i
55D-130 A
Open Network and Sharing Center

3. You may need to key in the network security key for a secured wireless network, then
click OK.

5 o D =

Type the network security key

e
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4. Wait while your computer is connecting to the wireless network.

6 oo, S =

Connecting to WL-530gV2

Cancel

5. The wireless connection is established successfully. The connection status is displayed
and the network icon displays the connected m status.

Currently connected to: o
F== WL-530qV2

Internet access
Wireless Network Connection -
WL-530gV2 Connected |
Asus-WIFI M =
As Office o
default M
S5D-130 o
DAOQ ot
SSD-10 o
Alva -

Open Network and Sharing Center
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Using the utilities

/ The Support DVD and Recovery DVD may not be included in the package. You may use
e the Recovery Partition feature to create the Support DVD and Recovery DVD. For details,
refer to Recovering your system in this chapter.

ASUS Al Suite ll

ASUS Al Suite Il is an all-in-one interface that integrates several ASUS utilities and allows
users to launch and operate these utilities simultaneously.

/ This utility is pre-installed on some models. For models without an operating system, follow
the steps below to install this utility.

Installing Al Suite Il
To install Al Suite II:

1. Place the support DVD in the optical drive. The Drivers installation tab appears if
Autorun is enabled.

2. Click the Utilities tab, then click ASUS Al Suite II.
3. Follow the onscreen instructions to complete the installation.

Using Al Suite Il

Al Suite Il automatically starts when you enter the Windows® operating system. The Al Suite
Il'icon appears in the Windows® notification area. Click the icon to open the Al Suite Il main
menu bar.

Click each button to select and launch a utility, to monitor the system, to update the
motherboard BIOS, to display the system information, and to customize the settings of Al
Suite II.

/m Tool | Monitor | Update | 2k | Settings |
ormabion v

Click to selecta Click to monitor Click to update the  Click to show Click to customize
utility sensors or CPU motherboard BIOS  the system the interface
frequency information settings
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The Tool menu
The Tool menu includes the EPU, Probe Il, and Sensor Recorder panels.

Launching EPU

EPU is an energy-efficient tool that provides you with a total power-saving solution. It detects
the current loading and intelligently adjusts the power usage in real-time. When you select
the Auto mode, the system changes modes automatically according to the current system
status. It allows you to customize each mode through configuring the settings such as CPU
frequency, vCore Voltage, and Fan Control.

To launch EPU:

. Click Tool > EPU on the Al Suite |l main menu bar.

Displays the following message
if no VGA power saving engine is
detected.

EPU Control Panel EPU Status

—_—
Mode

Auto A e Displays current mode

[ Tranquility

The items lighting up
means power saving
engine is activated

Performance

Raliabity TR i Displays the amount
of CO2 reduced
*Shifts between the
display of Total and
Current CO2 reduced
Displays the current
CPU power

Advanced settings for each mode
Displays the syst

Multiple system properties of each mode
operating modes

+ *Select From EPU Installation to show the CO2 that has been reduced since you
installed EPU.

+ *Select From the Last Reset to show the total CO2 that has been reduced since you
click the Clear button [EEEm],
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Launching and configuring Probe Il

Probe Il is a utility that monitors the computer’s vital components, and detects and alerts you
of any problem with these components. Probe Il senses fan rotations, CPU temperature,
and system voltages, among others. With this utility, you are assured that your computer is
always at a healthy operating condition.

To launch Probe II:

. Click Tool > Probe Il on the Al Suite Il main menu bar.

To configure Probe II:

. Click the Voltage/Temperature/Fan Speed tabs to activate the sensors or to adjust the
sensor threshold values.

. The Preference tab allows you to customize the time interval of sensor alerts, or
change the temperature unit.

Probe Il

Saves your
configuration

Loa;.i_s ymtl_r saved Loads the default Applies your
configuration threshold values changes

for each sensor
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Launching and configuring Sensor Recorder

Sensor Recorder allows you to monitor the changes in the system voltage, temperature, and
fan speed, as well as recording the changes.

To launch Sensor Recorder:

. Click Tool > Sensor Recorder on the Al Suite Il main menu bar.

To configure Sensor Recorder:

. Click the Voltage/Temperature/Fan Speed tabs and select the sensors that you want

to monitor.
. The History Record tab allows you to record the changes in the sensors that you
enable.
| "/ISUS  Sensor I;ecc;rder
Vol
v, +12v 7, +5V
Select the
sensors that you

want to monitor

Drag to view the
status during a
certain period
of time

Click to zoom in/out
the Y axis
Click to zoom in/out

lick to return to
¢ the X axis

the default mode

Chapter 6: Using the utilities



The Monitor menu
The Monitor menu includes the Sensor and CPU Frequency panels.

Launching Sensor

The Sensor panel displays the current value of a system sensor such as fan rotation, CPU
temperature, and voltages.

To launch Sensor:

Click Monitor > Sensor on the Al Suite Il main menu bar.

Launching CPU Frequency
The CPU Frequency panel displays the current CPU frequency and CPU usage.

To launch CPU frequency:

Click Monitor > CPU Frequency on the Al Suite Il main menu bar.

The Update menu

The Update menu allows you to update the motherboard BIOS and the BIOS boot logo with
the ASUS designed update utilities.

ASUS Update

The ASUS Update is a utility that allows you to manage, save, and update the motherboard
BIOS in Windows® OS. The ASUS Update utility allows you to update the BIOS directly
from the Internet, download the latest BIOS file from the Internet, update the BIOS from an
updated BIOS file, save the current BIOS file or view the BIOS version information.

Updating the BIOS through the Internet
To update the BIOS through the Internet:

1. From the ASUS Update screen, select Update BIOS from file, then click Next.
2. Select the ASUS FTP site nearest you to avoid network traffic.

Tick the two items if you want to enable the BIOS downgradable and Auto-BIOS
backup functions.

3. Select the BIOS version that you want to download, then click Next.

When no updated version is detected, a message is displayed informing you that there
is no new BIOS file from the BIOS server.

4. Click Yes if you want to change the boot logo, which is the image appearing on screen
during the Power-On Self-Tests (POST). Otherwise, click No.

5. Follow the onscreen instructions to complete the update process.
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Updating the BIOS through a BIOS file
To update the BIOS through a BIOS file:

1. From the ASUS Update screen, select Update BIOS from file, then click Next.
2. Locate the BIOS file from the Open window, click Open, and click Next.

3. Click Yes if you want to change the boot logo, which is the image appearing on screen
during the Power-On Self-Tests (POST). Otherwise, click No.

4. Follow the onscreen instructions to complete the update process.

The System Information screen

The System Information screen displays the information about the motherboard, CPU, and
memory slots.

Click the MB tab to see the details on the motherboard manufacturer, product name,
version, and BIOS.

Click the CPU tab to see the details on the processor and the Cache.

Click the SPD tab and then select the memory slot to see the details on the memory
module installed on the corresponding slot.

The Settings screen

The Settings screen allows you to customize the main menu bar settings and the interface’s
skin.

Application allows you to select the application that you want to enable.
Bar allows you to modify the bar setting,

Skin allows you to customize the interface’s contrast, brightness, saturation, hue, and
gamma.
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ASUS Al Manager

ASUS Al Manager is a utility which gives you quick and easy access to frequently-used
applications.

/ This utility is pre-installed on some models. For models without an operating system, follow
the steps below to install this utility.

Installing Al Manager
To install Al Manager:

1. Place the support DVD in the optical drive. If Autorun is enabled, the Drivers installation
wizard appears.

If Autorun is disabled, double-click the setup.exe file from the ASUS Al Manager folder in
the support DVD.

2. Click the Utilities tab, then click ASUS Al Manager.
3. Follow the onscreen instructions to complete the installation.
Launching Al Manager

To launch the Al Manager from the Windows® desktop, click Start > All Programs > ASUS >
Al Manager > Al Manager 1.xx.xx. The Al Manager quick bar appears on the desktop.

After launching the application, the Al Manager icon appears in the Windows® taskbar.

Right-click this icon to switch between the quick bar and the main window, and to launch the
Al Manager either from the quick bar or taskbar.

Al Manager quick bar

The Al Manager quick bar saves the desktop space and allows you to launch the ASUS
utilities or display system information easily. Click any of the Main, My Favorites, Support or

Information tab to display the menu’s contents.
== ([E] | Exit button
E:j Switch to main Window
L [l Add to ToolBar

Main Support
My Favorites Information

Click the Maximize/restore button Il to switch between full window and quick bar. Click the
Minimize button = to keep the Al Manager on the taskbar. Click the Close button = 1o quit
the Al Manager.

Main

The Main menu contains three utilities: Al Disk, Al Security, and Al Booting. Click the arrow
on the Main menu icon to browse through the utilities in the main menu.
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Al Disk

Al Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history,
or the Recycle Bin. Click the Al Disk icon on the quick bar to display the full Al Disk
window and select the items you want to clear. Click Apply when done.

Al Securit,
Al Security enables you to set a password to secure your devices, such as USB flash
disks and CD/DVD disks, from unauthorized access.

To lock a device:

1.

I e

When using Al Security for the first time, you are asked to set a password. Key in
a password with at most 20 alphanumeric characters.

Confirm the password.

Key in the password hint (recommended).

When done, click Ok.

Select the device you want to lock, then click Apply.

Key in the password you have set previously, then click Ok.

To unlock the device:

1.
2.

Deselect the locked device, then click Apply.

Key in the password you have set previously, then click Ok.

To change the password:

Click Change Password, then follow the onscreen instructions to change
password.

Al Booting
Al Booting allows you to specify the boot device priority sequence.

To specify the boot sequence:

1.
2.

Select a device, then click the left/right button to specify the boot sequence.
When done, press Apply.
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My Favorites
My Favorites allows you to add applications that you frequently use, saving you from

searching for the applications throughout your computer.
To add an application:

1. Click Add, then locate the application you want to add to My Favorites.
2. Click Open on the file location window. The application is added to My Favorites list.

Right click on the application icon to launch, delete, or rename the selected application. You
can also double click to launch the selected application.

Support

Click any links on the Support window to go to the ASUS website, technical support website,
download support website, or contact information.

Information

Click the tab on the Information window to see the detailed information about your system,
motherboard, CPU, BIOS, installed device(s), and memory.

Ai Charger

Ai Charger is a unique software that allows you to quickly charge your Apple devices such as
iPod, iPhone, and iPad on your ASUS computer’s USB 2.0 / USB 3.0 port.

At

There is no setting screen for Ai Charger. After its installation on your computer, the Ai
Charger icon appears on the Windows® taskbar.

+ The Ai Charger icon ( @, ) shows if an Apple device is connected on your computer’s
USB port.

+ Your Apple device can only be detected if its Apple USB driver is properly installed in it.

/ + The current Apple devices only support USB 2.0 performance. Even when you plug your
- Apple device into a USB 3.0 port, the maximum charging rate is still 500mA, which is the
USB 2.0 maximum charging rate. Ai Charger can increase this limit to 700mA~900mA.

There is no BIOS, hardware, or chipset requirements for Ai Charger.

ASUS CM6870 55



56

ASUS Webstorage

ASUS webstorage is designed to help you retrieve your data to your notebooks, smartphones
or tablets wherever there is internet connection.

/ This utility is pre-installed on some models. For models without an operating system, follow
the steps below to install this utility.

Installing webstorage
To install webstorage:

Place the support DVD in the optical drive. Double-click the setup.exe file from the ASUS
WebStorage folder in the Software folder in the support DVD.

Launching Webstorage
To launch the WebStorage from the 5 T

Windows® desktop, click Start > All m ME—B l _
Programs > ASUS > Webstorage.

The webstorage quick bar appears in the
Windows” taskbar. Right-click this icon to switch between the quick bar and the main window

© ASUS WebStorage - ol B

Storage not only provides you the oniline
with highest security standards, but also
utilizes Cloud Computing technology to develop
diversified applications. Let’s explore them alll

b

MySyncFolder Calendar. BookmarkSyncer Mobile App. Go to Web

Drive

Allows your to retrieve all your backups, synced files, share groups and password protected
data from here. Right-click the mouse to preview files before downloading or generating a
sharing URL.

Backup

To backup your most important data with simple steps: preset a backup shcedule with your
preferences in cloud storage; or select “Auto Backup” for complete data backup.
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MySyncFolder

To store the updated files to MySyncFolder for easy access and share of all types of files
without the limitation of location or device.
Calendar

ASUS WebStorage automatically syncs the most updated calendar events to all personal
computers so that you know the exact events no matter which PC is in use.

BookmarkSyncer

The convenient BookmarkSyncer keeps our browser preference and bookmark to the cloud
automatically synchronized in multiple computer.

MobileApp

ASUS WebStorage mobile applications sync your files between multiple devices. It also
supports transcoding technology that allows preview and files streaming on your mobile
phone.

Go to Web

Experience the value-added cloud service through ASUS WebStorage, without the risk of
losing data.

Settings

1. Click the Settings icon E the settings interface appears.

2. Follow the onscreen instructions to complete the configuration.

“:L Settings X

Language

Select

ferediigag: | English |

Upload speed setting

| Set ASUS WebStorage upload speed to

Proxy Settings
Set up a proxy to connect to the netwotk () Tumon (s) Tum off

HTTP Prozy: Port

Account Name Password :

i Apply

V3.0.94.193
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ASUS Easy Update

ASUS Easy Update is a software tool that automatically detects the latest drivers and
applications for your system.

1. From the Windows © notification area, s
right-click the ASUS Easy Update icon. e e 'i':=| [ p)

2. Select Schedule to set how often you

want to update your system. S'TE
. aily
3. Select Update to activate the update. e i

[v Weekly

Every second week
Monthly
Every third month

4. Click OK to display the items you can
download.

PXP5M1-DHS
C

Versin FileSze (KB

“wm

en_
& vouR-a7msrzaee

5. Check the item(s) you want to download,
and then click OK.

= FXPGMI-DHS ez ez —
| Asteio D22 Bcneckal  Ouncneck at

File Size (3]
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ASUS Instant On

ASUS Instant On gives you with a quick access to the Hybrid Sleep mode.

Using ASUS Instant On
To use ASUS Instant On:

The Instant On utility is pre-installed on your computer and _
automatically launches after starting up your computer. G @
1. When starting up your computer, you can see the utility el

icon E from Windows taskbar. -

2. Press <Alt + F1> and then click OK on
the confirmation message. Your system
will enter the Hybrid Sleep mode.

box next time.
% The default hotkey is <Alt + F1>. To = r—
change it, see the section below. -

Tick to not show this message next time.

Setting up ASUS Instant On
To set up ASUS Instant On:

1. Right-click the ASUS Instant On icon @
from Windows taskbar. The main settings
screen appears.

You can choose to enable/disable ASUS
Instant On hotkey, and show/hide ASUS
Instant On icon from Windows taskbar.

2. Click Redefine from the main settings
screen. The hotkey settings screen
appears.

3. Key in the combination keys you want to
use for ASUS Instant On hotkey.

4. Click OK to save your changes, and
Cancel to discard the changes you made.
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Nero 9

Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data

Installing Nero 9
To install Nero 9:

1. Insert the Nero 9 DVD into your optical drive.

2. If Autorun is enabled, the main menu appears automatically.

}ﬁ If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero
/ 9 DVD.

3. From the main menu, click Nero 9 Essentials.

4. Select the language you want to use for Installation Wizard. Click Next.

5. Click Next to continue.

6.  Tick I accept the License Conditions. When done, click Next.

7. Select Typical then click Next.

8.  Tick Yes, | want to help by sending anonymous application data to Nero then click

Next.
9. When done, click Exit.

Burning files

To burn files:

1. From the main menu, click Data Burning > Add.

2. Select the files that you want to burn. When done, click Add.

3. Aiter selecting files that you want to burn, click Burn to burn the files to a disc.

/ For more details about using Nero 9, refer to the Nero website at www.nero.com
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Recovering your system

Using the Recovery Partition

The Recovery Partition quickly restores your Desktop PC’s software to its original working
state. Before using the Recovery Partition, copy your data files (such as Outlook PST files)
to USB storage devices or to a network drive and make note of any customized configuration
settings (such as network settings).

About the Recovery Partition

The Recovery Partition is a reserved space on your hard disk drive used to restore the
operating system, drivers, and utilities installed on your Desktop PC at the factory.

R DO NOT delete the partition named T
RECOVERY. The Recovery Partition e
is created at the factory and cannotbe ~ ~ ‘
restored if deleted. Take your Desktop
PC to an authorized ASUS service
center if you have problems with the
recovery process.

Using the Recovery Partition:

1. Press <F9> during bootup.

2. Press <Enter> to select Windows Setup [EMS Enabled)].
3. Select one of the following recovery options.

System Recovery:
This feature allows you to restore the system to the factory default settings.

System Image Backup:

This feature allows you to burn the system image backup in DVD discs, which you can use
later to restore the system to its default settings.

System DVD Backup:
This feature allows you to make a backup copy of the support DVD.

4. Follow the onscreen instructions to complete the recovery process.

% Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Using the Recovery DVD (on selected models)

% Prepare 1~3 blank writable DVDs as instructed to create the Recovery DVD.

Remove the external hard disk drive before performing system recovery on your Desktop
PC. According to Microsoft, you may lose important data because of setting up Windows on
the wrong disk drive or formatting the incorrect drive partition.

To use the Recovery DVD:

1. Insert the Recovery DVD into the optical drive. Your Desktop PC needs to be powered
ON.

2. Restart the Desktop PC and press <F8> on bootup and select the optical drive (may be
labeled as “CD/DVD”) and press <Enter> to boot from the Recovery DVD.

Select OK to start to restore the image.

4. Select OK to confirm the system recovery.

R Restoring will overwrite your hard drive. Ensure to back up all your important data before
the system recovery.

5. Follow the onscreen instructions to complete the recovery process.

é DO NOT remove the Recovery disc, unless instructed to do so, during the recovery process
g or else your partitions will be unusable.

/ Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Troubleshooting

Troubleshooting

This chapter presents some problems you might encounter and the possible solutions.

? My computer cannot be powered on and the power LED on the front
panel does not light up

Check if your computer is properly connected.
. Check if the wall outlet is functioning.

. Check if the Power Supply Unit is switched on. Refer to the section Turning
your computer ON/OFF in Chapter 1.

? My computer hangs.

Do the following to close the programs that are not responding:

1. Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard,
then click Start Task Manager.

2. Click Applications tab.

3. Select the program that is not responding, then click End Task.

If the keyboard is not responding. Press and hold the Power button on the top
of your chassis until the computer shuts down. Then press the Power button
to turn it on.

? I cannot connect to a wireless nestwork using the ASUS WLAN Card
(on selected models only)?

Ensure that you enter the correct network security key for the wireless network
you want to connect to.

. Connect the external antennas (optional) to the antenna connectors on the
ASUS WLAN Card and place the antennas on the top of your computer
chassis for the best wireless performance.

?  The arrow keys on the number key pad are not working.

Check if the Number Lock LED is off. When the Number Lock LED is on,

the keys on the number key pad are used to input numbers only. Press the
Number Lock key to turn the LED off if you want to use the arrow keys on the
number key pad.
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No display on the monitor.

Check if the monitor is powered on.

Ensure that your monitor is properly connected to the video output port on
your computer.

If your computer comes with a discrete graphics card, ensure that you connect
your monitor to a video output port on the discrete graphics card.

Check if any of the pins on the monitor video connector is bent. If you discover
bent pins, replace the monitor video connector cable.

Check if your monitor is plugged to a power source properly.

Refer to the documentation that came with your monitor for more
troubleshooting information.

When using multiple monitors, only one monitor has display.

Ensure that the both monitors are powered on.

During POST, only the monitor connected to the VGA port has display. The
dual display function works only under Windows.

When a graphics card is installed on your computer, ensure that you connect
the monitors to the output port on the graphics card.

Check if the multiple displays settings are correct. Refer to section
Connecting multiple external displays in Chapter 3 for details.

My computer cannot detect my USB storage device.

The first time you connect your USB storage device to your computer,
Windows automatically installs a driver for it. Wait for a while and go to My
Computer to check if the USB storage device is detected.

Connect your USB storage device to another computer to test if the USB
storage device is broken or malfunctions.

| want to restore or undo changes to my computer’s system settings
without affecting my personal files or data.

The Windows® System Restore feature allows you to restore or undo changes
to your computer’s system settings without affecting your personal data such
as documents or photos. For more details, refer to the section Restoring your
system in Chapter 2.
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?  The picture on the HDTV is distorted.

It is caused by the different resolutions of your monitor and your HDTV. Adjust
the screen resolution to fit your HDTV. To change the screen resolution:

1. Do any of the following to open the Screen Resolution setting screen:

+ Click L= I8 Control Panel > Appearance and Personalization >
Display > Change display settings.

+ Right click anywhere on your Windows desktop. When the pop-up
menu appears, click Personalize > Display > Change display
settings.

2. Adjust the resolution. Refer to the documentation came with your HDTV
for the resolution.

3. Click Apply or OK. Then click Keep Changes on the confirmation
message.

? My speakers produce no sound.

Ensure that you connect your speakers to the Line out port (lime) on the front
panel or the rear panel.

. Check if your speak is connected to a electrical source and turned on.
Adjust your speakers’ volume.
Ensure that your computer’s system sounds are not Muted.
If it is muted, the volume icon is displayed as m . To enable the system
sounds, click m from the Windows notification area, then click 4 .
+  Ifitis not muted, click m and drag the slider to adjust the volume.

Connect your speakers to another computer to test if the speakers arer
working properly.

?  The DVD drive cannot read a disc.

. Check if the disc is placed with the label side facing up.

. Check if the disc is centered in the tray, especially for the discs with
non-standard size or shape.

Check if the disc is scratched or damaged.

=)

The DVD drive eject button is not respond.

1. Click & > Computer.

= A
2. Right-click sesel TOREE= o click Eject from the menu.
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Power

Problem

No power
(The power
indicator is off)

Possible Cause

Incorrect power voltage

Action

+ Set your computer’s power voltage
switch to your area’s power
requirements.

+ Adjust the voltage settings. Ensure
that the power cord is unplugged
from the power outlet.

Your computer is not
turned on.

Press the power key on the front panel
to ensure that your computer is turned
on.

Your computer’s power
cord is not properly
connected.

+ Ensure that the power cord is
properly connected.
+ Use other compatible power cord.

PSU (Power supply unit)
problems

Try installing another PSU on your
computer.

Display

Problem

No display
output after
turning the
computer on
(Black screen)

Possible Cause

The signal cable is

not connected to the
correct VGA port on your
computer.

Action

+ Connect the signal cable to the
correct display port (onboard VGA or
discrete VGA port).

« If you are using a discrete VGA
card, connect the signal cable to the
discrete VGA port.

Signal cable problems

Try connecting to another monitor.
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LAN

Problem

Cannot access
the Internet

Possible Cause

The LAN cable is not
connected.

Action

Connect the LAN cable to your
computer.

LAN cable problems

Ensure the LAN LED is on. If not,
try another LAN cable. If it still does
not work, contact the ASUS service
center.

Your computer is not
properly connected to a
router or hub.

Ensure that your computer is properly
connected to a router or hub.

Network settings

Contact your Internet Service Provider
(ISP) for the correct LAN settings.

Problems caused by the
anti-virus software

Close the anti-virus software.

Driver problems

Reinstall the LAN driver

Audio
Problem Possible Cause Action
) + Refer to your computer’s user
Spealker or headphone is manual for the correct port.
connected to the wrong )
port. + Disconnect and reconnect the
speaker to your computer.
. Speaker or headphone Try using another speaker or
No Audio does not work. headphone.
The front and back audio Try both the front a_nd back aU(_:ilo
ports. If one port failed, check if the
ports do not work. : .
port is set to multi-channel.
Driver problems Reinstall the audio driver
ASUS CM6870
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System

Problem Possible Cause Action
Too many programs are
many prog Close some of the programs.
running.
System speed is + Use an anti-virus software to
too slow scan for viruses and repair your

Computer virus attack computer.

Reinstall the operating system.

Send the damaged hard disk

drive to ASUS Service Center for
servicing.

Replace with a new hard disk drive.

Hard disk drive failure

Replace with compatible memory
modules.

The system often | Memory module problems Remove the extra memory
hangs or freezes. modules that you have installed,
then try again.

There is not enough
air ventilation for your
computer.

Move your computer to an area with
better air flow.

Incompatible softwares are | Reinstall the OS and reinstall
installed. compatible softwares.
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CPU

Problem Possible Cause Action

It is normal. The fan runs on its
Your computer is booting full speed when the computer is

up. powering on. The fan slows down
after entering the OS.
T?to ntO|sy_ right The BIOS settings have Restore the BIOS to its default
after turning on been changed. settings.

the computer.

Update the BIOS to the latest
version. Visit the ASUS Support
site at http:/support.asus.com to
download the latest BIOS versions.

Old BIOS version

Ensure that you are using a
compatible or ASUS-recommended
CPU fan.

The CPU fan has been
replaced.

There is not enough
air ventilation for the
computer.

Ensure that your computer is

Computer is too working in an area with good air flow.

noisy when in use.

+ Update the BIOS.

The system temperature is | « If you know how to reinstall the
too high. motherboard, try to clean the inner
space of the chassis.

/ If the problem still persists, refer to your Desktop PC’s warranty card and contact the ASUS
b Service Center. Visit the ASUS Support site at http:/support.asus.com for the service
center information.
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ASUS contact information

ASUSTeK COMPUTER INC.
Address

Telephone

Fax

E-mail

Web site

Technical Support
Telephone
Online support

15 Li-Te Road, Peitou, Taipei, Taiwan 11259
+886-2-2894-3447
+886-2-2890-7798
info@asus.com.tw
www.asus.com.tw

+86-21-38429911
support.asus.com

ASUS COMPUTER INTERNATIONAL (America)

Address
Telephone
Fax

Web site

Technical Support
Telephone

Support fax

Online support

800 Corporate Way, Fremont, CA 94539, USA
+1-510-739-3777

+1-510-608-4555

usa.asus.com

+1-812-282-2787
+1-812-284-0883
support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)

Address

Fax

Web site
Online contact

Technical Support

Telephone (Component)

Telephone (System/Notebook/Eee/LCD)
Support Fax

Online support

Harkort Str. 21-23, D-40880 Ratingen, Germany
+49-2102-959911

www.asus.de

www.asus.de/sales

+49-1805-010923*
+49-1805-010920*
+49-2102-9599-11
support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile

phone.

Manufacturer: ASUSTeK Computer Inc.

Address: No.150, LI-TE RD., PEITOU, TAIPEI 112,
TAIWAN

Authorised representative in ASUS Computer GmbH

Europe:

Address: HARKORT STR. 21-23, 40880 RATINGEN,
GERMANY
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Copyright © 2012 ASUSTeK Computer Inc. Alle Rechte vorbehalten.

Kein Teil dieses Handbuchs, einschlieBlich der darin beschriebenen Produkte und Software, darf
ohne ausdrtickliche, schriftliche Genehmigung von ASUSTeK COMPUTER INC. (“ASUS”) in
irgendeiner Form, ganz gleich auf welche Weise, vervielféltigt, Ubertragen, abgeschrieben, in einem
Wiedergewinnungssystem gespeichert oder in eine andere Sprache tibersetzt werden.

Produktgarantien oder Service werden nicht geleistet, wenn: (1) das Produkt repariert, modifiziert
oder abgewandelt wurde, auBer schriftlich von ASUS genehmigte Reparaturen, Modifizierung oder
Abwandlungen; oder (2) die Seriennummer des Produkts unkenntlich gemacht wurde oder fehlt.

ASUS STELLT DIESES HANDBUCH “SO, WIE ES IST”, OHNE DIREKTE ODER INDIREKTE
GARANTIEN, EINSCHLIESSLICH, JEDOCH NICHT BESCHRANKT AUF GARANTIEN ODER
KLAUSELN DER VERKAUFLICHKEIT ODER TAUGLICHKEIT FUR EINEN BESTIMMTEN ZWECK,
ZUR VERFUGUNG. UNTER KEINEN UMSTANDEN HAFTET ASUS, SEINE DIREKTOREN,
VORSTANDSMITGLIEDER, MITARBEITER ODER AGENTEN FUR INDIREKTE, BESONDERE,
ZUFALLIGE ODER SICH ERGEBENDE SCHADEN (EINSCHLIESSLICH SCHADEN AUF

GRUND VON PROFITVERLUST, GESCHAFTSVERLUST, BEDIENUNGSAUSFALL ODER
DATENVERLUST, GESCHAFTSUNTERBRECHUNG UND AHNLICHEM), AUCH WENN ASUS VON
DER WAHRSCHEINLICHKEIT DERARTIGER SCHADEN AUF GRUND VON FEHLERN IN DIESEM
HANDBUCH ODER AM PRODUKT UNTERRICHTET WURDE.

SPEZIFIKATIONEN UND INFORMATIONEN IN DIESEM HANDBUCH DIENEN AUSSCHLIESSLICH
DER INFORMATION, KONNEN JEDERZEIT OHNE ANKUNDIGUNG GEANDERT WERDEN

UND DURFEN NICHT ALS VERPFLICHTUNG SEITENS ASUS AUSGELEGT WERDEN. ASUS
UBERNIMMT FUR EVENTUELLE FEHLER ODER UNGENAUIGKEITEN IN DIESEM HANDBUCH
KEINE VERANTWORTUNG ODER HAFTUNG, EINSCHLIESSLICH DER DARIN BESCHRIEBENEN
PRODUKTE UND SOFTWARE.

In diesem Handbuch angegebene Produkt- und Firmennamen kénnen u.U. eingetragene Warenzeichen
oder Urheberrechte der entsprechenden Firmen sein und dienen nur der Identifizierung oder Erkldrung zu
Gunsten des Eigentlimers, ohne Rechte verletzen zu wollen.
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Erkldrungen

ASUS Recycling/Riicknahmeservices

Das ASUS-Wiederverwertungs- und Rticknahmeprogramm basiert auf den Bestrebungen,
die hichsten Standards zum Schutz der Umwelt anzuwenden. Wir glauben, das

die Bereitstellung einer Lésung flir unsere Kunden die Méglichkeit schafft, unsere
Produkte, Batterien, andere Komponenten und ebenfalls das Verpackungsmaterial
verantwortungsbewuBt der Wiederverwertung zuzufiinren. Besuchen Sie bitte die Webseite
unter http://csr.asus.com/english/Takeback.htm fiir Details zur Wiederverwertung in
verschiedenen Regionen.

REACH

Die rechtliche Rahmenbedingungen flir REACH (Registration, Evaluation, Authorisation,
and Restriction of Chemicals) erfiillend, verdffentlichen wir die chemischen Substanzen in
unseren Produkten auf unserer ASUS REACH-Webseite unter
http://cst.asus.com/english/index.aspx.

Erklarung der Federal Communications Commission

Dieses Gerat stimmt mit den FCC-Vorschriften Teil 15 tberein. Sein Betrieb unterliegt
folgenden zwei Bedingungen:

+  Dieses Gerét darf keine schédigenden Interferenzen erzeugen, und

+  Dieses Gerét muss alle empfangenen Interferenzen aufnehmen, einschlieBlich
derjenigen, die einen unerwtinschten Betrieb erzeugen.

Dieses Gerat ist auf Grund von Tests fiir Ubereinstimmung mit den Einschrénkungen

eines Digitalgeréts der Klasse B, geméas Teil 15 der FCC-Vorschriften, zugelassen.

Diese Einschrankungen sollen bei Installation des Gerats in einer Wohnumgebung auf
angemessene Weise gegen schéadigende Interferenzen schiitzen. Dieses Gerét erzeugt und
verwendet Hochfrequenzenergie und kann, wenn es nicht gemé&B den Anweisungen des
Herstellers installiert und bedient wird, den Radio- und Fernsehempfang empfindlich stéren.
Es wird jedoch nicht garantiert, dass bei einer bestimmten Installation keine Interferenzen
auftreten. Wenn das Gerat den Radio- oder Fernsehempfang empfindlich stért, was sich
durch Aus- und Einschalten des Gerats feststellen I&sst, ist der Benutzer ersucht, die
Interferenzen mittels einer oder mehrerer der folgenden MaBnahmen zu beheben:

+  Empfangsantenne neu ausrichten oder an einem anderen Ort aufstellen.
+  Den Abstand zwischen dem Gerét und dem Empfanger vergréBern.

+ Das Gerét an die Steckdose eines Stromkreises anschlieBen, an die nicht auch der
Empfénger angeschlossen ist.

«  Den Handler oder einen erfahrenen Radio-/Fernsehtechniker um Hilfe bitten.

4& Um Ubereinstimmung mit den FCC-Vorschriften zu gewahrleisten, miissen abgeschirmte
Kabel flir den Anschluss des Monitors an die Grafikkarte verwendet werden. Anderungen
oder Modifizierungen dieses Gerits, die nicht ausdrticklich von der fir Ubereinstimmung
verantwortlichen Partei genehmigt sind, kénnen das Recht des Benutzers, dieses Gerét zu
betreiben, annullieren.
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RF-Aussetzungswarnung

Dieses Gerét und die integrierte Antenne durfen nicht ndher als 20 cm an lhrem Kérper oder
in der Nahe befindenden Personen installiert und betrieben werden. Dieses Gerat und seine
Antenne(n) diirfen nicht zusammen oder in der Ndhe mit anderen Antennen oder Sendern
betrieben werden. Endnutzer miissen die spezifischen Betriebsanleitungen flir eine RF-
Aussetzung innerhalb der anerkannten Bereiche befolgen.

Erkldrung des kanadischen Ministeriums fiir Telekommunikation

Dieses Digitalgerat lberschreitet keine Grenzwerte flir Funkrauschemissionen der Klasse
B, die vom kanadischen Ministeriums flir Telekommunikation in den Funkstérvorschriften
festgelegt sind.

Dieses Digitalgerét der Klasse B stimmt mit dem kanadischen ICES-003 tberein.

Macrovision Corporation-Produktanmerkung

Dieses Produkt verfigt tiber Kopierschutztechnologie, die durch methodische

Anforderungen bestimmter U.S.A.-Patente und anderer geistiger Eigentumsrechte der
Macrovision Corporation und anderer Parteien geschlitzt sind. Die Verwendung dieser
Kopierschutztechnologie muss von Macrovision Corporation genehmigt werden und ist,
wenn nicht anderweitig von der Macrovision Corporation genehmigt, nur flir private
oder eingeschrénkte Vorflihrungszwecke vorgesehen. Reverse-Engineering oder Demontage
ist verboten.

Warnung: Lithium-lonen-Akkus

CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the
same or equivalent type recommended by the manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.

VORSICHT! Explosionsgefahr bei unsachgeméBen Austausch der Batterie. Ersatz nur
durch denselben oder einem vom Hersteller empfohlenem ahnlichen Typ. Entsorgung
gebrauchter Batterien nach Angaben des Herstellers.




Sicherheitsinformationen

R Bevor Sie das Gerat reinigen, trennen Sie es von der Stromversorgung. Wischen Sie den
Desktop PC mit einem weichen Tuch oder einem Fensterleder ab, das Sie mit einer Lésung
aus einem nicht scheuernden Reinigungsmittel und einigen Tropfen warmem Wasser
angefeuchtet haben. Wischen Sie verbleibende Feuchtigkeit mit einem trockenen Tuch ab.

NICHT auf ungerade oder instabile Oberfl&chen aufstellen. Bei Beschéddigung des
Gehduses den Kundendienst aufsuchen.
KEINER schmutzigen oder staubigen Umgebung aussetzen. KEIN Betrieb wahrend
eines Gaslecks.

+  KEINE Gegenstande auf die Oberfldche fallenlassen und keine Fremdgegenstédnde in
den Desktop PC einfthren.

+  KEINEN magnetischen oder elektrischen Feldern aussetzen.
KEIN Aussetzen oder Betreiben in der ndhe von Flussigkeiten, Regen oder Feuchtigkeit.
KEIN Modembetrieb wéhrend eines elektrischen Sturms.
Akku-Sicherheitswarnung: Batterie NICHT in offenes Feuer werfen. Kontakte NICHT
kurzschlieBen. Den Akku NICHT auseinandernehmen.
Dieses Produkt in Umgebungstemperaturen zwischen 0°C (32°F) und 35°C (95°F)
verwenden.
Die Lufteinldsse des Desktop PCs NICHT abdecken, um eine Uberhitzung des Systems
zu vermeiden.

KEINE beschddigten Stromkabel, Zubehérteile oder andere Peripheriegeréte
verwenden.

Den Kabel zur Vermeidung eine Stromschlags aus der Steckdose herausziehen, bevor
das System bewegt wird.

+  Suchen Sie Fachpersonal auf, bevor ein Adapter oder Verldngerungskabel verwendet
wird. Solche Geréte kénnen den Schutzkreislauf fur die Erdung unterbrechen.

+ Die Netzteilspannung sollte der értlichen Stromversorgung entsprechen. Falls
Sie sich liber die Spannung der Stromversorgung unsicher sind, wenden Sie sich an
Ihren Stromversorger.

Falls das Netzteil ausféllt, reparieren Sie es nicht selbst. Wenden Sie sich an
qualifiziertes Fachpersonal oder lhren Héndler.
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Darstellungssystematik

Um sicherzustellen, dass Sie bestimmte Aufgaben richtig ausflihren, beachten Sie bitte die
folgenden Symbole und Schriftformate, die in diesem Handbuch verwendet werden.

) é \ GEFAHR/WARNUNG: Informationen zum Vermeiden von
Verletzungen beim Ausfuhren einer Aufgabe.

'\ VORSICHT: Informationen zum Vermeiden von Schaden an den
o Komponenten beim Ausflihren einer Aufgabe.

k WICHTIG: Anweisungen, die Sie beim Ausfihren einer Aufgabe
befolgen mussen.

/ HINWEIS: Tipps und zusatzliche Informationen zur Erleichterung
bei der Ausftihrung einer Aufgabe.

Weitere Informationsquellen

An den folgenden Quellen finden Sie weitere Informationen und Produkt- sowie Software-
Updates.

ASUS-Webseiten

ASUS-Webseiten enthalten weltweit aktualisierte Informationen tiber ASUS-Hardware
und Softwareprodukte. Beziehen Sie sich auf die ASUS-Webseite unter
WWW.asus.com.

Vor-Ort Technische Unterstiitzung

Besuchen Sie die ASUS-Webseite unter http:/support.asus.com/contact fir
Kontaktinformationen der Technischen Untersttitzung vor Ort.
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Verpackungsinhalt

Ve
ASUS Essentio Desktop PC 1x Tastatur
1x Maus 1x Netzkabel 1x Nero 9 Burning Software
DVD/SDVD/RDVD
(optional)

Anstaion Gude

1x Installationshilfe 1x Garantiekarte 1x Antenne (optional)
/ + Sollten 0.g. Artikel beschadigt oder nicht vorhanden sein, wenden Sie sich bitte an lhren
- Héndler.

Die oberhalb illustrierten Artikel sind nur als eine Referenz gedacht. Die tatséchlichen
Produktspezifikationen kénnen sich je nach Modell unterscheiden.
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Willkommen!

Vielen Dank fur den Kauf eines ASUS Essentio CM6870 Desktop PCs!

Der ASUS Essentio CM6870 Desktop PC liefert topaktuelle Leistung, unvergleichliche
Zuverldssigkeit und benutzerorientierte Anwendungen. All diese Eigenschaften wurden in
diesem verbltiffend futuristischen und eleganten Systemgehéuse vereint.

R Lesen Sie die ASUS Garantiekarte sorgfaltig durch, bevor Sie Ihren ASUS Desktop PC in
Betrieb nehmen.

Kennenlernen des Computers

/ Abbildungen werden nur zu lhrer Referenz bereitgestellt. Anschllisse und deren Platzierung
- sowie Gehdusefarben variieren mit verschiedenen Modellen.

Vorderseite

exeANSION BAY

ASUS CM6870
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1. USB 3.0-Anschliisse. Diese Universal Serial Bus 3.0 (USB 3.0)-Anschllisse nehmen
USB 3.0-Geréte wie Maus, Drucker, Kamera, PDA und andere Geréte auf.

2.  USB 2.0-Anschliisse. Diese Universal Serial Bus 2.0 (USB 2.0)-Anschltisse nehmen
USB 2.0-Gerate wie Maus, Drucker, Kamera, PDA und andere Gerate auf.
Mikrofonanschluss (rosa). Dieser Anschluss verbindet mit einem Mikrofon.

4.  Kopfhéreranschluss (hellgriin). Dieser Anschluss verbindet mit Kopfhérern oder
Lautsprechern.

5.  Einschalttaste. Driicken Sie diese Taste, um Ihren Computer einzuschalten.

6.  Auswurftaste fiir optisches Laufwerk. Driicken Sie diese Taste, um das Laufwerk zu
offnen.

7.  Schacht fiir optisches Laufwerk (leer). Hier kénnen Sie ein zusatzliches optisches
Laufwerk einbauen.

8.  Schacht fiir Optisches Laufwerk. In diesem Laufwerksfach befindet sich ein
optisches Laufwerk.

9.  Memory Stick™-/Memory Stick Pro™-Kartensteckplatz. Flhren Sie eine Memory
Stick™-Karte / Memory Stick Pro™-Karte in diesen Steckplatz ein.

10. Secure Digital™-/ MultiMediaCard-Kartensteckplatz. Fiihren Sie eine Secure
Digital™-Karte / MultiMediaCard-Karte in diesen Steckplatz ein.

11.  CompactFlash®-/ Microdrive™-Kartensteckplatz. Flihren Sie eine CompactFlash®-
Karte / Microdrive™-Karte in diesen Steckplatz ein.
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1. Stromanschluss. Verbinden Sie das Netzkabel mit diesem Anschluss.

% Anforderungen: 115V~ /220-230V~, 7A/4A. 60/50Hz.

2.  Stromschalter. Schaltet die Stromversorgung fiir lnren Computer An/Aus.

3. USB 2.0-Anschliisse. Diese Universal Serial Bus 2.0 (USB 2.0)-Anschltisse nehmen
USB 2.0-Geréte wie Maus, Drucker, Kamera, PDA und andere Gerate auf.

4. HDMI-Anschluss. Dies ist High-Definition Multimedia Interface (HDMI)-Anschluss
und ist kompatibel mit HDCP, um die Wiedergabe von HD DVD, Blu-Ray und anderen
geschdtzten Inhalten zu ermdglichen.

5. DVI-D-Anschluss. Dieser Anschluss nimmt DVI-D-kompatible Gerate auf und ist
HDCP-konform. Dies ermdglicht die Wiedergabe von HD DVDs, Blu-Ray Disks und
anderen geschtitzten Inhalten.

6.  USB 3.0-Anschliisse. Diese Universal Serial Bus 3.0 (USB 3.0)-Anschllisse nehmen
USB 3.0-Geréte wie Maus, Drucker, Kamera, PDA und andere Gerate auf.

% + Bei der Installation eines Windows®-Betriebssystems verbinden Sie KEINE Tastatur /
e Maus mit den USB 3.0-Anschliissen.

Der Beschrankungen des USB 3.0-Controllers wegen, kénnen USB 3.0-Geréte nur unter
Windows® und nur nach der Installation eines USB 3.0-Treibers verwendet werden.

USB 3.0-Geréte kénnen nur als Datenspeicher verwendet werden.

+ Wir empfehlen lhnen, fiir eine schnellere Datenlibertragung und bessere Leistung alle
USB 3.0-Geréte mit den USB 3.0-Anschllissen zu verbinden.

7.  Seitenlautsprecherausgang (grau). Dieser Anschluss verbindet in einer 8-Kanal-
Audiokonfiguration mit den Seitenlautsprechern.

8.  Hinterer Lautsprecherausgang (schwarz). Dieser Anschluss verbindet in einer 4-
Kanal-, 6-Kanal- oder 8-Kanal-Audiokonfiguration mit den hinteren Lautsprechern.

9.  Mitte/Subwoofer-Anschluss (orange). Dieser Anschluss verbindet mit den Mitte-/
Subwoofer-Lautsprechern.

10. Mikrofonanschluss (rosa). Dieser Anschluss verbindet mit einem Mikrofon.

11.  Line Out-Anschluss (hellgriin). Dieser Anschluss verbindet mit Kopfhérern oder
Lautsprechern. In 4-Kanal-, 6-Kanal- und 8-Kanalkonfigurationen wird dieser Anschluss
zum Frontlautsprecherausgang.

12. Line In-Anschluss (hellblau). Dieser Anschluss verbindet mit Tonband-, CD- oder
DVD-Playern und anderen Audiogeréten.

/ Die Funktionen der Audioausgénge in 2, 4, 6 oder 8-Kanalkonfigurationen entnehmen Sie
G- bitte der folgenden Audio-Konfigurationstabelle.
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13.

14.

15.

16.

Audio 2, 4, 6, oder 8-Kanalkonfigurationen

Anschliisse Kg_;l)(f:::r 4-Kanal 6-Kanal 8-Kanal
Hellblau Line In Line In Line In Line In
Hellgriin I Line Out I Frontlautsprecher I Frontlautsprecher I Frontlautsprecher

Rosa | Micin | Mic In | Mic In | Mic In
Orange I - I - I Mitte/Subwoofer I Mitte/Subwoofer
Schwarz I - I Hinterer Lautsprecher I Hinterer Lautsprecher I Hinterer Lautsprecher
I I I I

Grau

Seitenlautsprecher

Blenden fiir Erweiterungssteckplétze. Entfernen Sie die Blende beim installieren
einer Erweiterungskarte.

ASUS WLAN-Karte (nur bei bestimmten Modellen). Mit dieser optionalen WLAN-
Karte kann lhr Computer sich mit einem Drahtlosnetzwerk verbinden.

ASUS-Grafikkarte (nur bei bestimmten Modellen). Die Anzeigeausgénge dieser
optionalen ASUS-Grafikkarte variieren je nach Modell.

LAN (RJ-45)-Anschluss. Dieser Anschluss erméglicht Gigabit-Verbindungen zu einem
Local Area Network (LAN) mittels eines Netzwerk-Hub.

LED-Anzeigen am LAN-Anschluss

ACT/LINK SPEED
LED LED
Aktivitats-/Verbindungs- LED  Geschwindigkeits-LED
- -
AUS Nicht verbunden | AUS 10Mbps-Verbindung -
ORANGE | Verbunden | ORANGE | 100Mbps-Verbindung
BLINKEND | Datenaktivitdt | GRUN | 1Gbps-Verbindung LAN-
Anschluss
17.  VGA-Anschluss. Dieser Anschluss ist fir einen VGA-Monitor oder andere VGA-
kompatible Gerate vorgesehen.
18. PS/2 Kombianschluss fiir Tastatur / Maus (lila/griin). Fur den Anschluss einer PS2-
Maus oder -Tastatur.
19. Liiftungsoffnungen. Diese Offnungen dienen der Luftzirkulation.

84

Blockieren Sie nicht die Liftungséffnungen am Gehduse und sorgen Sie bitte immer flir
ausreichende Luftzirkulation fiir Ihren Computer.
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Einrichten Ihres Computers

Dieser Abschnitt flihrt Sie durch das AnschlieBen Ublicher Hardware-Geréte wie einen
externen Monitor, Tastatur, Maus und Stromkabel an lhren Computer.

AnschlieBen eines externen Monitors

ASUS Grafikkarte verwenden (nur an bestimmten Modellen)

Verbinden Sie den Monitor mit dem Anzeigeausgang der aufgesetzten ASUS Grafikkarte.
So verbinden Sie einen externen Monitor mit der ASUS Grafikkarte:

1. Verbinden Sie einen Monitor mit dem Anzeigeausgang der ASUS-Grafikkarte.

2. SchlieBen Sie den Monitor an die Stromversorgung an.

/ Die Anzeigeausgénge der ASUS Grafikkarten kénnen sich je nach Modell unterscheiden.
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Verwenden der integrierten Anzeigeanschliisse
SchlieBen Sie den Monitor an den integrierten Anzeigeanschluss an.

So verbinden Sie einen externen Monitor mithilfe der integrierten Anzeigeanschliisse:

1. Verbinden Sie ein VGA-Monitor mit dem VGA-Anschluss oder ein DVI-D-Monitor

mit dem DVI-D-Anschluss oder ein HDMI-Monitor mit dem HDMI-Anschluss auf der
Riickseite Ihres Computers.

2. SchlieBen Sie den Monitor an die Stromversorgung an.

@

Lot

R + Falls Ihr Computer mit einer ASUS-Grafikkarte ausgestattet wurde, ist die Grafikkarte in

BIOS als priméres Anzeigegerét eingestellt. Verbinden Sie den Monitor deshalb mit dem
Anzeigeausgang der ASUS-Grafikkarte.

+ Um mehrere externe Monitore mit dem Computer zu verbinden, beziehen Sie sich auf

den Abschnitt AnschlieBen von mehreren externen Anzeigegeréten in Kapitel 3
dieses Benutzerhandbuchs.
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AnschlieBen einer USB-Tastatur und USB-Maus

Verbinden Sie eine USB-Tastatur und USB-Maus mit den USB-Anschliissen auf der
Rucktafel (Ruickseite) lhres Computers.

>
BOTOBOT000
ool

/ Verbinden Sie eine USB-Tastatur und -Maus mit den USB 2.0-Anschltissen.

AnschlieBen des Netzkabels

Verbinden Sie ein Ende des Netzkabels mit dem Stromanschluss auf der Rticktafel
(Rtickseite) Inres Computers und das andere Ende mit der Steckdose.
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Ein-/Ausschalten lhres Computers.

Dieser Abschnitt beschreibt, wie Sie den Computer nach dem Einrichten Ein-/Ausschalten
kénnen.

Computer einschalten

So schalten Sie den Computer ein:

1. Schalten Sie den Stromschalter ein.
2. Schalten Sie den Monitor ein.

3. Driicken Sie die Einschalttaste Ihres Computers.

Einschalttaste

I

4. Warten Sie, bis das Betriebssystem automatisch hochlédt.

Computer ausschalten
So schalten Sie den Computer aus:

1. SchlieBen Sie alle laufenden Anwendungen.

2. Klicken Sie im Windows®-Desktop auf E .

3. Klicken Sie auf (Herunterfahren), um das Betriebssystem
herunterzufahren.

88 Kapitel 1: Erste Schritte



Verwenden von Windows® 7

Das erste Starten

Beim ersten Start Inres Computers erscheint eine Abfolge von Fenstern, um Sie durch die

Konfiguration der Grundeinstellungen lhres Windows Windows® 7 Betriebssystems zu fiihren.

So fiihren Sie den Erststart aus:

1. Schalten Sie den Computer ein. Warten Sie einige Minuten, bis das Fenster Windows
einrichten (Set Up Windows) erscheint.

2. Waéhlen Sie in der Dropdownliste lhre Sprache. Klicken Sie auf Weiter (Next).

3. Wahlen Sie aus der Dropdownliste Ihr Land (Country) oder Region, Zeit (Time) und
Wahrung (Currency) sowie Tastatur-Layout (Keyboard Layout). Klicken Sie auf
Next (Weiter).

4. Geben Sie einmalige Namen flir Benutzername (user name) und Computername
(Computer name) ein. Klicken Sie auf Weiter (Next).

5. Geben sie die bendtigten Informationen ein, um lhr Kennwort einzurichten, und klicken
Sie auf Weiter (Next). Sie kénnen auch auf Weiter (Next) klicken und diesen Schritt
ohne ein Kennwort einzugeben zu Uberspringen.

/ Falls Sie spéter einen Benutzernamen oder Kennwort einrichten méchten, beziehen Sie
sich auf den Abschnitt Benutzerkonto und Kennwort einrichten in diesem Kapitel.

6.  Lesen Sie sorgfdltig die Lizenzbedingungen (License terms). Wéhlen Sie Ich
akzeptiere die Lizenzbedingungen (I accept the license terms) und klicken Sie auf
Weiter (Next).

7. Wahlen Sie zwischen Empfohlene Einstellungen verwenden (Use recommended
settings) oder Nur wichtige Updates installieren (Install important updates only),
um Sicherheitseinstellungen lhres Computers einzustellen. Um diesen Schritt zu
liberspringen, wahlen Sie Spéter nachfragen (Ask me later).

8.  Uberpriifen Sie die Zeit- und Datumseinstellungen. Klicken Sie auf Weiter (Next).
Das System ladet die neuen Einstellungen und startet erneut. Sie kénnen jetzt mit der
Verwendung lhres Computers beginnen.
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Windows® 7 Desktop verwenden

/ Klicken Sie auf das Startsymbol a 7"‘ > Hilfe und Support (Help and Support), um weitere
Informationen tiber Windows® 7 zu erhalten.

Das Startmenii verwenden

Das Startment ermdglicht lhnen den Zugang zu Programmen, Anwendungen und anderen
nitzlichen Elementen auf Inrem Computer. Ebenso bietet es Ihnen weitere Informationen
liber Windows 7 durch die Funktionen von Hilfe und Support (Help and Support).

Elemente im Startmenii ausfiihren
So fiihren Sie Elemente im Startmenii aus:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol

2. Wahlen Sie im Startment das Element, welches Sie ausflihren mdchten.

/ Sie kénnen Programme, die Sie dauerhaft im Startmenu anzeigen méchten, an das
Startmen anheften. Fur weitere Details beziehen Sie sich auf den Abschnitt Programme
an Startmenii oder Taskleiste anheften in diesem Kapitel.

Das Element Getting Started verwenden

Das im Startmenti aufgelistete Element Erste Schritte (Getting Started) enthélt
Informationen uber allgemeine Aufgaben wie das Personalisieren von Windows®, Hinzufligen
neuer Benutzer und Dateitransfer, um Sie mit der Benutzeroberflache von Windows® 7
vertraut zu machen.

So verwenden Sie das Element Erste Schritte:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol E um das Startment( zu
offnen.

Wahlen Sie Erste Schritte (Getting Started). Eine Liste mdglicher Aufgaben erscheint.
Wabhlen Sie die gewtinschte Aufgabe.

Taskleiste verwenden

Die Taskleiste ermdglicht das Starten und die Verwaltung der auf lhrem Computer
installierten Programme oder Elemente.

Ein Programm aus der Taskleiste starten
So starten Sie ein Programm aus der Taskleiste:

. Klicken Sie auf ein Symbol in der Windows®-Taskleiste, um es zu auszuftihren. Klicken
Sie erneut auf das Symbol, um das Programm auszublenden.

/ Sie kénnen Programme, die Sie dauerhaft anzeigen méchten, an die Taskleiste anheften.
Fur weitere Details beziehen Sie sich auf den Abschnitt Programme an Startmenii oder
Taskleiste anheften in diesem Kapitel.
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Elemente an die Sprunglisten anheften

Ein Rechtsklick auf ein Symbol in der Taskleiste ladet die Sprungliste (Jumplist), um lhnen
einen Schnellzugang zu Bezugslinks eines Programms oder Elements zu erleichtern. Sie
koénnen Elemente wie Webseiten-Favoriten, oft verwendete Ordner oder Laufwerke sowie
kirzlich abgespielte Mediendateien an die Sprungliste (Jumplist) anheften.

So heften Sie Elemente an die Sprungliste an:

1. Klicken Sie mit der rechten Maustaste ein Symbol in der Taskleiste an.

2. Klicken Sie mit der rechten Maustaste auf das gewtinschte Element in der Sprungliste
und wahlen Sie An diese Liste anheften (Pin to this list).

Elemente von der Sprungliste I6sen
So Iésen Sie Elemente von der Sprungliste:

1. Klicken Sie mit der rechten Maustaste ein Symbol in der Taskleiste an.

2. Klicken Sie mit der rechten Maustaste auf das gewtinschte Element in der Sprungliste
und wéhlen Sie Von dieser Liste I6sen (Unpin from this list).

Programme an Startmenii oder Taskleiste anheften
So heften Sie Programme ans Startmenii oder Taskleiste an:

3
1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol , um das Startment zu
laden.

2. Klicken Sie mit der rechten Maustatste auf das Gewtinschte Element.

3. Wahlen Sie An Taskleiste anheften (Pin to Taskbar) oder An Startmenii anheften
(Pin to Start menu).

% Sie kénnen auch das Symbol eines aktuell ausgeflinrten Programms mit der rechten
- Maustaste anklicken und Dieses Programm an Taskleiste anheften (Pin this program to
taskbar) auswahlen.

Programme vom Startmenti I6sen
So l6sen Sie Programme vom Startmen(i:

3
1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol , um das Startmend zu
laden.

2. Kilicken Sie mit der rechten Maustaste auf das gewtinschte Programm in der Startment
und wahlen Sie Von dieser Liste 16sen (Unpin from this list).

Programme von der Taskleiste I6sen
So losen Sie Programme von der Taskleiste:

1. Klicken Sie in der Taskleiste das gewtinschte Programm mit der rechten Maustaste an
und wahlen Sie Dieses Programm von der Taskleiste I6sen (Unpin this program
from taskbar).
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Infobereich verwenden
In der Standardeinstellung sind folgende Symbole im Infobereich aufgelistet:

Benachrichtigung fiir Wartungscenter

E Hier kénnen Sie durch das Anklicken dieses Symbols Warnnachrichten/Benachrichtigungen
anzeigen und das Windows®-Wartungscenter laden.

Netzwerkverbindung

Dieses Symbol zeigt den Verbindungsstatus und Signalstarke der Kabel- oder Drahtlos-
Netzwerkverbindung.

Lautstérke
i)

Zur Einstellung der Lautstérke klicken Sie auf dieses Symbol.

Warnnachricht anzeigen
So zeigen Sie eine Warnnachricht an:

. Klicken Sie auf das Benachrichtigungssymbol E und dann auf die Nachricht, um
diese anzuzeigen.

/ Fiir weitere Details beziehen Sie sich auf den Abschnitt Windows®-Wartungscenter
- verwenden in diesem Kapitel.

Symbole und Benachrichtigungen anpassen

Sie kénnen die Symbole und Benachrichtungen in der Taskleiste oder im Infobereich
wahlweise ein- oder ausblenden.

So passen Sie Symbole und Benachrichtungen an:

1. Klicken Sie im Infobreich auf das Pfeilsymbol E
2. Klicken Sie auf Anpassen (Customize).

3. Wabhlen Sie in der Dropdownliste die gewtinschte Verhaltensweise von Symbolen oder
Elementen, die Sie anpassen mdchten.

lhre Dateien und Ordner verwalten

Windows® Explorer verwenden

Mit Windows® Explorer konnen Sie lhre Dateien und Ordner ansehen, verwalten und
organisieren.

Windows® Explorer 6ffnen
So 6ffnen Sie den Windows Explorer:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol = , um das Startmen( zu
laden.

2. Klicken Sie auf Computer, um den Windows Explorer zu éffnen.
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Dateien und Ordner durchsuchen
So durchsuchen Sie Dateien und Ordner:
1. Offnen sie Windows Explorer.
Suchen Sie im Navigations- oder Ansichtsbereich nach dem Ort lhrer Daten.

Klicken Sie in der Breadcrumb-Leiste auf den Pfeil, um den Inhalt eines Laufwerks
oder Ordners anzuzeigen.

Datei-/Ordneransicht anpassen
So passen Sie die Datei-/Ordneransicht an:
1. Offnen Sie Windows Explorer.

Wéhlen Sie im Navigationsbereich den Ort lhrer Daten.

2
3. Klicken Sie in der Symbolleiste auf das Symbol Ansicht &= ~.
4

Bewegen Sie den Auswahlregler im Ansichtsmenti, um die Ansicht der Datei oder des
Ordners anzupassen.

% Sie kénnen auch mit der rechten Maustaste den Ansichtsbereich irgendwo anklicken,
- Ansicht (View) wéhlen und die gewlinschte Ansichtsart bestimmen.

Dateien ordnen

So ordnen Sie Dateien:

1. Offnen Sie Windows Explorer.

2. Klicken Sie im Feld Anordnen (Arrange by), um die Dropdownliste anzuzeigen.
3. Wahlen Sie die gewtinschte Anordnungsart.

Dateien sortieren

So sortieren Sie Dateien:

1. Offnen Sie Windows Explorer.

2. Rechtsklicken Sie irgendwo im Ansichtsbereich.

3. Wahlen Sie im erschienenen Kontextment Sortieren (Sort by) und dann die von
Ihnen gewtinschte Sortierungsmethode.

Dateien gruppieren

So gruppieren Sie Dateien:

1. Offnen Sie Windows Explorer.

2. Rechtsklicken Sie irgendwo im Ansichtsbereich.

3. Wahlen Sie im erschienenen Kontextment Gruppieren (Group by) und dann die von
Ihnen gewtinschte Gruppierungsmethode.
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Neuen Ordner hinzufiigen
So filigen Sie einen neuen Ordner hinzu:

1. Offnen Sie Windows Explorer.
2. Klicken in der Taskleiste auf Neuer Ordner (New folder).
3. Wabhlen Sie einen Namen flir den neuen Ordner.

% Sie kénnen auch den Ansichtsbereich mit der rechten Maustaste anklicken und
- Neu (New) > Ordner (Folder) wahlen.

Dateien sichern

Ein Backup erstellen
So erstellen Sie ein Backup:

1. Klicken Sie auf > Alle Programme (All Programs) > Wartung (Maintenance) >
Sichern und wiederherstellen (Backup and Restore).

2. Klicken Sie auf Sicherung einrichten (Set up backup). Klicken Sie auf Weiter (Next).
Wéhlen Sie einen Zielort fiir Inren Backup. Klicken Sie auf Weiter (Next).

4. Wabhlen Sie entweder Auswahl durch Windows (empfohlen) (Let Windows choose
(recommended)) oder Auswahl durch Benutzer (Let me choose) fir lhren Backup.

/ Falls Sie Auswahl durch Windows auswéhlen, wird Windows keine Programme, FAT-
formatierte Dateien, Papierkorbdateien oder Temporare Dateien von 1GB oder mehr
sichern.

5. Folgen Sie den Bildschirmanweisungen, um den Vorgang abzuschlieBen.

System wiederherstellen

Die Funktion Windows®-Systemwiederherstellung legt einen Wiederherstellungspunkt an,
in dem die Systemeinstellungen des Computers an einem Zeitpunkt/Datum gespeichert
werden. Dies erlaubt Ihnen die Wiederherstellung oder das Riickgédngigmachen von
Anderungen Ihres Computersystems, ohne dass Ihre persénlichen Daten betroffen werden.

So stellen Sie das System wieder her:

1. SchlieBen Sie alle laufenden Anwendungen.
2. Klicken Sie auf > Alle Programme (All Programs) > Zubehor (Accessories) >
Systemprogramme (System Tools) > Systemwiederherstellung (System Restore).

3. Folgen Sie den Bildschirmanweisungen, um den Vorgang abzuschlieBen.
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Computer schiitzen

Windows® 7-Wartungscenter verwenden

Windows® 7-Wartungscenter hilft Ihnen bei Warnnachrichten und bietet Sicherheits-
informationen, Informationen zur Systemwartung sowie die Méglichkeit einer automatischen
Problembehandlung und Behebung héufig auftretender Computerprobleme.

% Sie kénne die Benachrichtungen selbst anpassen. Fur weitere Details beziehen Sie sich
- auf den vorherigen Abschnitt Symbole und Benachrichtigungen anpassen in diesem
Kapitel.

Windows® 7-Wartungscenter ausfiihren
So fiihren Sie Windows® 7-Wartungscenter aus:

1. Klicken Sie zum Ausfiihren des Windows 7-Wartungscenter auf das Symbol E im
Infobereich und dann auf Wartungscenter 6ffnen (Open Action Center).

2. Klicken Sie im Windows 7-Wartungscenter auf die Aufgabe, die Sie ausfuhren
méchten.

Windows® Update verwenden

Windows Update erlaubt Ihnen den Abruf und Installation der neuesten Updates, um die
Sicherheit und Leistung lhres Computers zu verbessern.

Windows® Update ausfiihren

So fiihren Sie Windows® Update aus:

1. Klicken Sie in der Windows®-Taskleiste auf das Startsymbol , um das Startmenu zu

laden.
2. Waéhlen Sie Alle Programme (All Programs) > Windows Update.

3. Klicken Sie im Windows Update-Fenster auf die Aufgabe, die Sie ausftihren méchten.

Benutzerkonto und Kennwort erstellen

Sie kénnen fir andere Personen, mit Zugriff auf lhren Computer, weitere Benutzerkonten
sowie Kennwérter erstellen.

Ein Benutzerkonto erstellen
So konnen sie ein Benutzerkonto erstellen:

1. Kiicken Sie in der Windows®-Taskleiste auf €3 > Erste Schritte (Getting Started) >
Neue Benutzer hinzufligen (Add new users).

Wéhlen Sie Anderes Konto verwalten (Manage another account).
Wabhlen Sie Neues Konto erstellen (Create a new account).

Geben Sie den neuen Benutzernamen ein.

SR < A

Wéhlen Sie den Benutzertyp, entweder Standardbenutzer (Standard user) oder
Administrator.

6.  Zum Fertigstellen klicken Sie auf Konto erstellen (Create Account).
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Benutzerkennwort erstellen

So erstellen Sie ein Benutzerkennwort:

1. Waéhlen Sie den Benutzer, fir den Sie ein Kennwort erstellen méchten.
2. Wabhlen Sie Kennwort erstellen (Create a password).

3. Geben Sie ein Kennwort ein und bestétigen Sie es. Geben Sie ein Kennworthinweis
ein.

4. Zum Fertigstellen klicken Sie auf Kennwort erstellen (Create password).

Antivirus-Software aktivieren

Trend Micro Internet Security ist eine auf Ihren Computer vorinstallierte Antivirus-Software.
Nach der Aktivierung kénnen Sie es 60 Tage lang Probenutzen und eine lizenzierte Version
erwerben, nachdem die Probezeit abgelaufen ist.

So aktivieren Sie Trend Micro Internet Security:

1. Flhren Sie die Anwendung Trend Micro Internet Security aus.

2. Lesen Sie sorgféltig die Lizenzbedingungen (License terms). Klicken Sie auf
Zustimmen & Aktivieren (Agree & Activate).

Geben Sie lhre E-Mail-Adresse und |hren Standort ein. Klicken Sie auf Weiter (Next).
4. Klicken Sie auf Fertigstellen (Finish), um die Aktivierung abzuschlieBen.

Windows® Hilfe und Support

Windows® Hilfe und Support bietet lhnen Anleitungen und Antworten fir die Verwendung der
Anwendungen auf der Windows® 7-Plattform.

Um Windows® Hilfe und Support zu laden, klicken Sie auf © - Hilfe und Support (Help

and Support).
/ Stellen Sie sicher, dass Sie mit dem Internet verbunden sind, um die aktuellste Windows®-
Onlinehilfe abrufen zu kénnen.
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AnschlieBen von Geraten an lhren Computer

AnschlieBen eines USB-Datentréagers

Dieser Desktop PC enthélt USB 2.0/1.1- und USB 3.0-Anschltisse auf der Vorder- sowie
Riickseite. Die USB-Anschllisse ermdglichen lhnen das AnschlieBen von USB-Geréten wie
z.B. USB-Datentrager.

So schlieBen Sie einen USB-Datentréger an:

+  Stecken Sie den USB-Datentréger in Ihren Computer ein.

Vorderseite Riickseite

/ Sie kénnen USB-Datentréger mit den USB 3.0-Anschltissen verbinden.

So entfernen Sie einen USB-Datentréger:

1. Klicken Sie im Windows-Infobereich Ihres Computers
auf H und dann auf USB2.0-Flahslaufwerk auswerfen
(Eject USB2.0 FlashDisk). Der Name variiert je nach
USB-Datentrdgermodell.

&% Gerate und Drucker offnen

q Mass Storage auswerfen

- Wechseldatentrager (E:)

A e M lF e

7/9/2010

2. Wenn die Nachricht Hardware kann jetzt =
@ Hardware kann jetzt entfernt werden. X
entfernt werden (Safe to Remove Hardware) Das Gerat "USB-Massenspeichergerat” kann jetzt vom
eingeblendet wird, entfernen Sie den USB- o
Datentréger von lhrem Computer.

/
/ é E Entfernen Sie einen USB-Datentrager NICHT wéhrend eines laufenden Datentransfers.
¢ Dies kann zu Datenverlust flihren und den USB-Datentrdger beschadigen.
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AnschlieBen von Mikrofon und Lautsprechern

Dieser Desktop PC enthalt Mikrofon- und Lautsprecheranschltisse auf der Vorder- sowie
Ruickseite. Die auf der Riickseite gelegenen Audio E/A-Anschliisse erméglichen lhnen den
Anschluss von 2-Kanal, 4-Kanal, 6-Kanal, and 8-Kanal Stereolautsprechern.

Anschluss von Kopfhérern und Mikrofon

U

Anschluss von 2-Kanal Lautsprechern

©

AUDIO
INPUTS
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Anschluss von 4-Kanal Lautsprechern

AUDIO AUDIO
INPUTS INPUTS

o 4

Anschluss von 6-Kanal Lautsprechern

AUDIO AUDIO AUDIO

INPUTS INPUTS INPUTS
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Anschluss von 8-Kanal Lautsprechern
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AnschlieBen von mehreren externen Anzeigegeraten
Ihr Desktop PC enthélt evtl. VGA-, HDMI- und DVI-Anschllisse/Ausgénge und ermdglicht
lhnen das Verbinden von mehreren externen Anzeigegeraten.

R Wenn eine Grafikkarte auf lhren Computer installiert wurde, verbinden Sie die
Anzeigegerate mit den Anzeigeausgangen der Grafikkarte.

Einrichten mehrerer Anzeigegeréte

Wenn Sie mehrere Monitore verwenden, kénnen Sie die Anzeigemodi selbst bestimmen.
Sie kénnen einen zusatlichen Monitor als ein Duplikat lhres Hauptmonitors oder als eine
Erweiterung lhres Windows Desktops verwenden.

So richten Sie mehrere Anzeigegeréte ein:

1. Schalten Sie den Computer aus.

2. Verbinden Sie die zwei Monitore mit lnrem Computer sowie die Netzteile mit den
Monitoren. Beziehen Sie sich auf den Abschnitt Einrichten lhres Computer in Kapitel
1 fiir Details zum Verbinden eines Monitors mit Ihrem Computer.

/ Bei einigen Grafikkarten kann nur der zur Priméranzeige gesetzte Monitor eine Anzeige
~ wahrend des POST lieferen. Die Dual-Anzeige-Funktion funktioniert nur unter Windows.
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Schalten Sie den Computer ein.

4. Folgen Sei einer nachstehenden Vorgehensweisen, um das Einstellungsfenster
Bildschirmauflésung (Screen Resolution) zu 6ffnen:

+  Klicken Sie auf > Systemsteuerung (Control Panel) > Darstellung und
Anpassung (Appearance and Personalization) > Anzeige (Display) >
Anzeigeeinstellungen édndern (Change display settings).

+  Klicken Sie mit der rechten Maustaste irgendwo im Desktop. Wahlen
Sie im KontextmenU Anpassen (Personalize) > Anzeige (Display) >
Anzeigeeinstellungen @ndern (Change display settings).

5. Wabhlen Sie in der Dropdownliste Mehrere Anzeigen: (Multiple displays:) den
gewtinschten Anzeigemodus.

+  Diese Anzeigen duplizieren (Duplicate these displays): Treffen Sie diese
Auswahl, um den zusatzlichen Monitor als einen Duplikat lhres Hauptmonitors zu
verwenden.

+  Diese Anzeigen erweitern (Extend these displays): Treffen Sie diese Auswahl,
um den zusétzlichen Monitor als eine Erweiterung lhres Hauptmonitors zu
verwenden. Dies vergréBert lhren Desktop.

+  Desktop nur auf 1/2 anzeigen (Show desktop only on 1/ 2): Treffen Sie diese
Auswahl, um den Desktop auf Monitor 1 oder Monitor 2 anzuzeigen.

+  Diesen Bildschirm entfernen (Remove this display): Treffen Sie diese
Auswahl, um den ausgewé&hlten Monitor zu entfernen.

=« Darztllung und Anpazzung » Anzeige » Bildzchirmauflozung [ 43 || Syztermeteverung durchzuchen B

Andern Sie die Darstellung auf den Bildschirmen,

Ty | M

6.  Kiicken Sie auf Ubernehmen (Apply) oder auf OK und in der Bestétigungsnachricht
dann auf Anderungen beibehalten (Keep Changes).

Méchten Sie diese Anzeigeeinstellungen
beibehalten?

[ Anderungen beibehalten | [ Wiederherstellen |

In 12 Sekunden auf vorherige Anzeigeeinstellungen
zuriicksetzen
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AnschlieBen eines HDTV
Verbinden Sie ein High-Definition TV (HDTV) mit dem HDMI-Anschluss Ihres Computers.

% + Sie bendtigen ein HDMI-Kabel, um ein HDTV mit dem Computer zu verbinden. Das
- HDMI-Kabel muss separat erworben werden.

Um die beste Anzeigeleistung zu erhalten, sollte das HDMI-Kabel kiirzer als 15 Meter
sein.
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Computer verwenden

Richtige Sitzhaltung beim verwenden des Desktop PCs

Beim Verwenden des Desktop PCs ist die Einhaltung der richtigen Sitzhaltung erforderlich,
um Verspannungen lhrer Handgelenke, Hande und anderer Gelenke oder Muskeln zu
vermeiden. Dieser Abschnitt bietet lhnen Tipps zum Vermeiden von physischen Beschwerden
und mdéglichen Verletzungen beim Verwenden und Erfreuen lhres Desktop PCs.

Augen auf Augenhéhe mit
dem Ende des Monitors 1

4

90°-Winkel

Fussablage

So kénnen Sie die richtige Sitzhaltung sicherstellen:

Stellen Sie den Computerstuhl so ein, dass Ihre Ellbogen an oder etwas (iber der
Tastatur ruhen, um eine bequeme Tastaturschreibposition zu gewé&hrleisten.

Stellen Sie die Hohe lhres Stuhls ein, so dass die Knie etwas unter Ihren Hiiften liegen,
um die Riickseiten Ihrer Schenkel zu entspannen. Verwenden Sie, falls erforderlich,
eine Fussablage, um lhre Knie anzuheben.

Stellen Sie die Ricklehne Ihres Stuhls ein, so dass die Unterseite |hres Riickgrats fest
abgesttitzt und etwas nach hinten gewinkelt wird.

Sitzen Sie aufrecht, so dass lhre Knie, Ellbogen und Huften beim Sitzen vor dem PC in
etwa einen 90°-Winkel bilden.

Stellen Sie den Monitor direkt vor Ihnen auf und passen die Position der Oberseite
Ihres Bildschirms so auf Ihre Augenhéhe ein, dass lhre Augen etwas nach unten
blicken.

Platzieren Sie Ihre Maus nahe der Tastatur und verwenden Sie, falls nétig, eine
Handgelenkablage, um den Druck auf Ihre Handgelenke wéhrend des Tippens zu
senken.

. Verwenden Sie den Desktop PC in einer gutbeleuchteten Umgebung und halten Sie
ihn von starken Lichtquellen wie Fenstern und direkten Sonnenlicht fern.

Legen Sie beim Arbeiten mit dem Desktop PC regulére Minipausen ein.
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Speicherkartenleser verwenden

Digitale Kameras und andere digitale Aufnahmegerate verwenden Speicherkarten, um
digitale Bilder oder Medien zu speichern. Der auf der Vorderseite Ihres Systems integrierte
Speicherkartenleser ermdglicht das Lesen und Schreiben von und zu unterschiedlichen
Speicherkarten.

So verwenden Sie eine Speicherkarte:
1. Stecken Sie eine Speicherkarte in den Kartensteckplatz.
/ + Eine Speicherkarte ist gekerbt und ldsst sich nur in eine Richtung einpassen. Stecken

Sie die Karte NICHT gewaltsam in einen Steckplatz, um Schéden an der Karte zu
vermeiden.

+ Sie kénnen Speicherkarten in einen oder in mehrere Steckplétze einstecken und jede
voneinander unabhangig verwenden. Verwenden Sie jedoch nur eine Speicherkarte pro
Steckplatz.

2. Wabhlen Sie im AutoPlay-Fenster ein Programm, um auf die Dateien zuzugreifen.

/ + Falls AutoPlay auf Ihren Computer NICHT aktiviert ist, klicken Sie in der Taskleiste

- von Windows® 7 auf die Start-Taste, klicken Sie auf Arbeitsplatz (Computer) und
doppelklicken Sie das Speicherkartensymbol, um auf die darauf enthaltenen Daten
zuzugreifen.

+ Jeder Speicherkartenleser hat ein eigenes Laufwerkssymbol, welches im Fenster
Arbeitsplatz (Computer) aufgelistet wird.

+ Die LED eines Speicherkartenlesers leuchtet auf und blinkt, wenn Daten auf die
Speicherkarte geschrieben oder von der Speicherkarte gelesen werden.

w

Wenn abgeschlossen, klicken Sie mit der rechten Maustaste auf das Laufwerkssymbol
im Fenster Arbeitsplatz (Computer), klicken Sie auf Auswerfen (Eject), und
entfernen Sie dann die Speicherkarte.

Entfernen Sie eine Karte niemals wahrend oder sofort nach dem Lesen, Kopieren,
Formatieren oder L6schen von Daten auf der Karte, da die Daten eventuell verloren gehen.

g

y ‘ Um Datenverluste zu vermeiden, verwenden Sie die Funktion Hardware sicher entfernen
) und Medium auswerfen in Windows Infobereich, bevor Sie die Speicherkarte entfernen.
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Optisches Laufwerk verwenden

{

Optischen Datentréger einlegen
So legen Sie einen optischen Datentréger ein:

1. Driicken Sie beim eingeschalteten System die Auswurftaste, um das Laufwerk zu
6ffnen.

2. Legen Sie den Datentrdger in das Laufwerk, wobei die bedruckte Seite nach oben
zeigt.
3. Drticken Sie auf das Laufwerksfach, um es zu schlieBen.

4. Wahlen Sie im Fenster AutoPlay ein Programm, um auf die Dateien zuzugreifen.

/ Falls AutoPlay auf lhren Computer NICHT aktiviert ist, klicken Sie in der Taskleiste

von Windows® 7 auf die Start-Taste, klicken Sie auf Arbeitsplatz (Computer) und
doppelklicken Sie das CD/DVD-Laufwerkssymbol, um auf die darauf enthaltenen Daten
zuzugreifen.

Optischen Datentréger entfernen
So entfernen Sie einen optischen Datentréger:

1. Folgen Sie einer der folgenden Vorgehensweisen, um das Laufwerksfach auszuwerfen:
+  Driicken Sie die Auswurfstaste.

+  Klicken Sie im Fenster Arbeitsplatz (Computer) mit rechten Maustaste auf das
Laufwerkssymbol und wahlen Sie Auswerfen (Eject).

2. Entfernen Sie den Datentrdger aus dem Laufwerksfach.
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Multimedia-Tastatur verwenden
(nur bei bestimmten Modellen)

% Die Tastatur unterscheidet sich je nach Modell und Land. Die nachfolgende Abbildung ist
L nur zur Referenz gedacht.

ASUS PRIMAX/KB2621-Tastatur

Tasten Beschreibung

Systemlautstérke verringern

—_

Schaltet die Lautstérke zwischen
stumm/an.

n
S

N pEEERD

Systemlautstérke erhéhen

@

Springt zum vorherigen Titel im Media-
Player

Wiedergabe/Pause im Media-Player.

o

Springt zum ndchsten Titel im Media-
Player

o

Fur diese Tastatur sind keine Treiber erforderlich.

!

Die Sonderfunktionstasten funktionieren nur unter den Windows® Vista / Windows®
7-Betriebssystemen.
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ASUS KB34211 modern-Kabeltastatur

Schaltet die Lautstdrke zwischen
stumm/an.

Systemlautstérke verringern.

N

Systemlautstérke vergréBern.

/ Die Sonderfunktionstasten funktionieren nur unter den Windows® Vista / Windows®
- 7-Betriebssystemen.
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Einrichten der Internetverbindung

Kabelverbindung

Fuir eine Verbindung zwischen Ihrem Computer und DSL-/Kabelmodem oder Lokales
Netzwerk (Local Area Network / LAN) verwenden Sie ein RJ-45-Kabel.

Uber DSL-/Kabelmodem verbinden
So verbinden Sie via ein DSL-/Kabelmodem:

1. Richten Sie das DSL-/Kabelmodem ein.

/ Beziehen Sie sich auf die Dokumentation, die mit Inrem DSL-/Kabelmodem geliefert wurde.

2. Verbinden Sie ein Ende des RJ-45-Kabels mit dem LAN (RJ-45)-Anschluss auf der
Riickseite Ihres Computers und das andere Ende mit dem DSL-/Kabelmodem.

SadeEeneny
SEnREats
oo
KBS

s 3
o A
moa|
o SEEEED ) o
OSSSESEE50)
@l nesceeiciccield
Seieee
Dn] \(90000000 O/
00 ‘OOOOOOOOOOO 00
dap | -
oy P
: Cesn

RJ-45 cable

Schalten sie den DSL-/Kabelmodem und lhren Computer ein.

Konfigurieren Sie die nétigen Einstellungen flr die Internetverbindung.

/P Fir Details und Hilfestellung zur Einrichtung einer Internetverbindung wenden Sie sich an
- Ihren Internetdienstanbieter (ISP).
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Uber ein lokales Netzwerk (LAN) verbinden
So verbinden Sie sich via LAN:

1. Verbinden Sie ein Ende des RJ-45-Kabels mit dem LAN (RJ-45)-Anschluss auf der
Riickseite Inres Computers und das andere Ende mit dem (Internet) LAN.

s ...x.,.,sg(.,aa.,.sx.,.a. ®

S900
§ ) S %%%
e

O SS S S SEEs 550

WJ

2. Schalten sie den Computer ein.

3. Konfigurieren Sie die nétigen Einstellungen fiir die Internetverbindung.

/ Fiir Details und Hilfestellung zur Einrichtung einer Internetverbindung wenden Sie sich an
L Ihren Internetdienstanbieter (ISP).
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Drahtlosverbindung (nur an bestimmten Modellen)

Verbinden Sie den Computer durch eine Drahtlosverbindung mit dem Internet.

R Um eine Drahtlosverbindung herzustellen, miissen Sie sich mit einem drahtlosen
Zugriffspunkt (AP) verbinden.

o%ooooo

@ Wireless AP

®

% + Um die Reichweite und Empfindlichkeit des drahtlosen Funksignals zu erhéhen,
A verbinden Sie die externen Antennen mit dem Antennenanschluss lhrer ASUS WLAN-
Karte.

Fiir den besten Empfang legen Sie die Antennen oben auf Ihren Computer.

Die externen Antennen sind optionale Artikel.

So verbinden Sie sich mit dem Drahtlosnetzwerk:

1. Klicken Sie im Infobereich auf das Netzwerksymbol n um verfligbare
Drahtlosnetzwerke anzuzeigen.

2. Wiéhlen Sie ein Drahtlosnetzwerk, mit dem Sie sich verbinden méchten, und klicken
Sie auf Verbinden (Connect).

3. Sie missen evtl. einen Sicherheitsschltissel fir eine verschltisselte Drahtlosverbindung
eingeben, klicken Sie dann auf OK.

4. Warten Sie, wéhrend |hr Computer sich mit dem Drahtlosnetzwerk verbindet.

Die Drahtlosverbindung wurde erfolgreich eingerichtet. Der Verbindungsstatus wird
angezeigt und das Netzwerksymbol zeigt den Status Verbunden (Connected) m an.
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So verbinden Sie sich mit einen Wireless-Netzwerk:

1. Klicken Sie in der Taskleiste auf das Wireless-Netzwerk-Symbol n um verfligbare

netzwerke anzuzeigen.

Not mnne;ted 4
dﬂﬂ Connections are available

Wireless Network Connection N
WL-530g¥2 T
Asus-WIFE )

As Office ol

S5D-10 ot

DAOQ i

S5D-130 ot

Open Netwark and Sharing Center

E— P rintKey 2000 1510 (Full)
1035aM |
9/4/2009

2 fio [N ) = Ly

2. Wadbhlen Sie das gewtinschte Wireless-Netzwerk aus und klicken Sie dann auf

Verbinden.

" ~
Mot connected o |t
il connections ae available
Wireless Network Connection -~
WL-530gV2 \
Connect automatically ‘.
Asus-WIFI .

As Office 1.‘“

DACQ .

$SD-10 ﬂ\‘

Ala .

55D-130 -
Open Network and Sharing Center

3. Sie mlssen mdglicherweise den Netzwerksicherheitsschllissel eingeben, wenn Sie
sich mit einen gesicherten Netzwerk verbinden wollen. Klicken Sie danach auf OK.

presm—

Type the network security key

secunty ke @
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4. Warten Sie einen Moment, bis sich der Computer mit dem Wireless-Netzwerk
verbunden hat.

CET=— )

Connecting to WL-530gV2 ...

Cancel

5. Die Wireless-Verbindung wurde erfolgreich hergestellt. Der Verbindungsstatus wird
angeziegt und das Netzwerksymbol zeigt den Verbindungsstatus an.

Currently connected to: o
F== WL-530qV2

Internet access
Wireless Network Connection -
WL-530gV2 Connected |
Asus-WIFI M =
As Office o
default M
S5D-130 "
DAOQ "
SSD-10 o
Alva ol -

Open Network and Sharing Center
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Verwenden der Hilfsprogramme

% Die Support-DVD und die Wiederherstellungs-DVD sind méglicherweise nicht im
Lieferumfang enthalten. Sie kénnen diese selbst erstellen/brennen. Weitere Details finden
Sie in System wiederherstellen.

ASUS Al Suite Il

ASUS Al Suite Il ist eine komplett integrierte Oberfléche, die mehrere ASUS-Anwendungen vereint
und dem Benutzer erlaubt, diese Anwendungen gleichzeitig zu starten und laufen zu lassen.

/ Dieses Programm ist bei einigen Modelln schon installiert. Bei Modellen ohne
“ Betriebssystem folgen Sie zur Installation den folgenden Schritten.

Al Suite Il installieren
So installieren Sie Al Suite II:

1. Legen Sie die Support-DVD in das optische Laufwerk. Das Treiberinstallations-Menti
erscheint, falls Autorun auf lhrem Computer aktiviert ist.

2. Klicken Sie auf die Auswahl Utilities, und dann auf Al Suite Il.

3. Folgen Sie den Bildschirmanweisungen, um die Installation fertigzustellen.

Al Suite Il verwenden

Al Suite Il wird automatisch beim Start von Windows®-Betriebssystem ausgeftihrt. Das

Al Suite II-Symbol erscheint daraufhin auf der Windows®-Taskleiste. Klicken Sie auf das

Symbol, um die Hauptmendlileiste von Al Suit Il einzublenden.

Klicken Sie auf die Anwendungssymbole, um das jew. Programm zu starten, das System

zu liberwachen oder das BIOS zu aktualisieren, Systeminformationen anzuzeigen und die
Einstellungen von Al Suite Il anzupassen.

Vsl yst =
Tool Monitor Update 25 ?m Settings
Information v

Anwendung Uberwachung der  Motherboard-BIOS ~ Systeminfos Programmeinstel-
auswahlen Sensoren und der  aktualisieren anzeigen lungen anpassen
CPU-Frequenz

R + Die Anwendungen im Menti Tool (Extras) variieren mit Modellen.

+ Die Abbildungen von Al Suite Il in diesem Benutzerhandbuch sind nur zu Ihrer Referenz
gedacht. Die tatséchlichen Anzeigen variieren mit Modellen.
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Tool (Extras)

Dieses Ment enthalt Panele flir EPU, Probe Il und Sensorschreiber.

EPU starten und konfigurieren

EPU ist eine energiesparende Anwendung, die verschiedenen Betriebsanforderungen
nachkommen kann. Es erkennt die derzeitige Belastung und regelt die Stromversorgung
intelligent in Echtzeit. Die Auswahl von Auto mode (Autom. Modus) lasst das System
automatisch, dem aktuellen Systemstatus entsprechend, zwischen den Modi schalten. Sie
konnen jeden Modus durch die Konfiguration der Einstellungen wie CPU-, GPU-Frequenz,
vCore-Spannung und Lufterkontrolle auch selbst anpassen.

So starten Sie EPU:

. Klicken Sie im Al Suite Il Hauptmenti auf Tool (Extras) > EPU.

Wenn keine VGA Energiespar-
Engine gefunden wurde, wird
folgende Meldung angezeigt

X |

EPU Control Panel EPU Status
Mode
Aktueller Modus
: Tranquility .
s )| %9 Wenn ein Element aufleuchtet,
Performance | Convenience | — ist die Energiespar-Engine
aktiviert

Reliability d Zeigt die CO2-Reduzierung an

* Schaltet zwischen der
aktuellen und gesamten CO2-
Reduzierung

Zeigt die aktuelle CPU-
Leistung an

Erweiterte Einstellungen fiir jeden Modus

y i haften
Y fiir jeden Modus

% *» Wahlen Sie From EPU Installation (Seit EPU-Installation), um die CO2-Reduzierung

seit der Installation von EPU anzuzeigen.

*+ Wahlen Sie From the Last Reset (Seit dem Reset), um die gesamte CO2-Reduzierung
seit dem Drlicken der Taste Clear (L6schen) IEEEEE anzuzeigen.
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Probe Il starten und konfigurieren

Das Programm PC Probe Il tiberwacht die wichtigsten Komponenten des Computers und
informiert Sie, falls Probleme entdeckt werden. PC Probe Il erkennt unter anderem die
Lifterdrehzahlen, die CPU-Temperatur und Systemspannungen. Mit Hilfe dieses Programms
werden optimale Betriebsbedingungen flir Ihren Computer garantiert.

So starten Sie Probe II:

. Klicken Sie im Al Suite Il Hauptment auf Tool (Extras) > Probe II.

Probe Il konfigurieren:

Klicken Sie auf Voltage (Spannung)/Temperature (Temperatur)/Fan Speed
(Luftergeschwindigkeit), um die Sensoren zu aktivieren oder deren Grenzwerte
anzupassen. Preference (Bevorzugte Einstellungen) ermdglicht die Anpassung des
Zeitintervalls fiir Sensorwarnungen oder die Anderung der Temperatureinheiten.

T, e . )
7ISUS Probe Il » Lo

0,650
veore 0,944y T

v 12.384 V.

5200V i

Load Defaul
/m Tool Monitor Utldate

Konfiguration
speichern

Einstellungen
libernehmen

Konfiguration
laden

Standardgrenzwerte fiir
jeden Sensor laden
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Sensor Recorder (Sensorschreiber) starten und konfigurieren

Sensor Recorder (Sensorschreiber) ermdglicht die Uberwachung und Aufzeichnung der
Anderungen bei Systemspannungen, Temperaturen und Lliftergeschwindigkeiten.

So starten Sie Sensor Recorder:

. Klicken Sie im Al Suite Il Hauptment auf Tool (Extras) > Sensor Recorder.

Sensor Recorder konfigurieren:
Klicken Sie auf Voltage (Spannung)/Temperature (Temperatur)/Fan Speed

(Ltiftergeschwindigkeit) und wéahlen Sie die Sensoren, die liberwacht werden sollen.
History Record (Verlauf) ermdglicht die Verlaufsaufzeichnung der aktivierten Sensoren.

"/ISUS  Sensor Recorder

voltage | Ten

Allows you to monitor the changes in the system valtage.

Sensorauswahl (fiir e i
die Uberwachung)

Ziehen, um einen be-
stimmten Zeitpunkt
einzusehen

Auf der Y-Achse
vergréBern/verkleinern
Auf der X-Achse
Zuriick zum vergréBern/verkleinern
Standardmodus
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Monitor

Die Auswahl Monitor (Uberwachung) enthélt die Bereiche Sensor und CPU Frequency
(CPU-Frequenz).

Sensor

Der Bereich Sensor zeigt die aktuellen Werte eines Systemsensors an, einschlieBlich
Lufterdrehzahlen, CPU-Temperatur und Spannungen. Klicken Sie im Hauptmenti von
Al Suite Il auf Monitor (Uberwachung) > Sensor, um den Bereich Sensor zu laden.

CPU Frequency

Der Bereich CPU Frequency (CPU-Frequenz) zeigt die aktuelle CPU-Frequenz und CPU-
Auslastung an. Klicken Sie im Hauptment von Al Suite Il auf Monitor (Uberwachung) >
CPU Frequency (CPU-Frequenz), um den Bereich CPU Frequency (CPU-Frequenz) zu
laden.

Update

Die Auswahl Update (Aktualisierung) erméglicht Ihnen, mit Hilfe der hauseigenen ASUS-
Anwendungen, die Aktualisierung des Motherboard-BIOS und des BIOS-Bootlogos
vorzunehmen.

ASUS Update

Das Programm ASUS Update gestattet Ihnen, das Motherboard-BIOS in der Windows®-
Umgebung zu verwalten, speichern und aktualisieren. Mit dem ASUS Update-Programm
kénnen Sie das BIOS direkt vom Internet aus aktualisieren, die aktuellste BIOS-Datei
vom Internet herunterladen, das BIOS mit einer aktuellen BIOS-Datei aktualisieren, die
vorliegende BIOS-Datei speichern, die Informationen tber die BIOS-Version betrachten.

So aktualisieren Sie das BIOS liber das Internet:

1. Wahlen Sie im Fenster ASUS Update Update BIOS from Internet (BIOS tiber das
Internet aktualisieren) und driicken Sie auf Next (Weiter).

2. Wahlen Sie den lhnen am nachsten gelegenen ASUS FTP-Ort aus, um starken
Netzwerkverkehr zu vermeiden.

Falls Sie die Funktionen BIOS downgradable (BIOS-Downgrade) und auto BIOS
backup (Autom. BIOS-Sicherung) aktivieren méchten, wéhlen Sie das entsprechende
Késtchen (vor der Funktion) an.

3. Wahlen Sie die BIOS-Version, die heruntergeladen werden soll und klicken Sie dann
auf Next (Weiter).

Falls keine aktualisierte Version gefunden wurde, erscheint eine entsprechende
Nachricht auf der rechten Seite.

4. Falls Sie das Boot-Logo, bzw. das wahrend des Power-On-Self-Tests (POST)
erscheinende Bild, &ndern mdéchten, klicken Sie auf Yes (Ja). Ansonsten klicken Sie
auf No (Nein), um fortzufahren.

5. Folgen Sie dann den Bildschirmanweisungen, um den Aktualisierungsprozess abzu-
schlieBen.
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So kénnen Sie das BIOS (iber eine BIOS-Datei aktualisieren:

1. Waéhlen Sie im Fenster ASUS Update Update BIOS from file (BIOS (iber eine BIOS-
Datei aktualisieren) und drticken Sie auf Next (Weiter).

2. Suchen Sie die BIOS-Datei im Fenster Open (Offnen), klicken Sie auf Open (Offnen)
und anschlieBend auf Next (Weiter).

3. Sie kénnen entscheiden, ob das BIOS Boot-Logo geédndert werden soll. Klicken Sie auf
Yes (Ja), um das Boot-Logo zu dndern oder No (Nein), um fortzufahren.

4. Folgen Sie dann den Bildschirmanweisungen, um den Aktualisierungsprozess abzu-
schlieBen.

System Information

Der Bereich System Information enthélt Informationen tber das Motherboard, die CPU und
die Speichersteckplatze.

Klicken Sie auf die Auswahl MB, um weitere Details liber den Motherboard-Hersteller,
den Produktnamen, die Version und das BIOS anzuzeigen.

Klicken Sie auf die Auswahl CPU, um weitere Details Uber den Prozessor und die Cache
anzuzeigen.

Klicken Sie auf die Auswahl SPD und wéhlen Sie einen Speichersteckplatz, um weitere
Details tiber den auf dem entsprechenden Steckplatz installierten Speichermodul
anzuzeigen.

Support

In Support wrden Informatiuonen Uber die ASUS-Webseite, die technische Hilfe-Webseite.
die Download-Webseite und Kontaktinformationen angezeigt.

Einstellungen
Der Bereich Settings (Einstellungen) erlaubt Ihnen die Anpassung der Hauptmentileiste
sowie das Erscheinungsbild der Benutzeroberfléche.
+ Ermdglicht die Auswahl der Anwendungen, die aktiviert werden sollen.
Ermdglicht die Einstellung der Leiste (Hauptmend).

Ermdglicht die Anpassung von Kontrast, Helligkeit, Sattigung, Farbton und Gamma in
der Benutzeroberflache.
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ASUS Al Manager

ASUS Al Manager ist ein Hilfsprogramm, welches Ihnen schnellen Zugriff auf oft verwendete
Anwendungen ermdglicht.

% Dieses Programm ist bei einigen Modelln schon installiert. Bei Modellen ohne
Betriebssystem folgen Sie zur Installation den folgenden Schritten.

Al Manager installieren
So installieren Sie Al Manager:

1. Legen Sie die Support-DVD in das optische Laufwerk. Die DVD zeigt automatisch das
Treiber-Mend an, wenn Autorun auf Ihrem Computer aktiviert ist.

Falls Autorun deaktiviert ist, doppelklicken Sie die Datei setup.exe im Ordner ASUS Al
Manager auf der Support-DVD.

2. Kiicken Sie auf die Auswahl Hilfsprogramme (Utilities) und dann auf ASUS Al-Manager.

3. Folgen Sie den Bildschirmanweisungen, um die Installation fertigzustellen.

Al Manager starten

Um Al-Manager vom Windows®-Desktop zu starten, klicken Sie auf Start > Alle
Programme (All Programs) > ASUS > Al Manager > Al Manager 1.xx.xx. Die Al-Manager
Schnellstartleiste erscheint auf dem Desktop.

Nach dem Start der Anwendung erscheint das Al-Manager-Symbol in der Windows®-Taskleiste.

Klicken Sie mit der rechten Maustaste auf das Symbol, um zwischen der Leiste und dem
Hauptfenster umzuschalten und den Al Manager entweder aus der Schnellstart- oder der
Taskleiste aus zu starten.

Al Manager Schnellstartleiste

Die Al Manager Schnellstartleiste halt Ihren Desktopplatz frei und ermdglicht das einfache
Starten von Hilfsprogrammen oder das Anzeigen von Systeminfos. Klicken Sie auf die
Auswahl Hauptfenster (Main), Meine Favoriten (My Favorites), Support oder Information, um
die Inhalte der entsprechenden Mentis anzuzeigen.

| — |[=d Beenden
i. ' I 3 7 E;L! Zum Hauptfenster
i - 4|l=H— Zur Toolbar hinzufiigen

Hauptfenster Support
Meine Favoriten Information
Klicken Sie auf €l (Maximieren), um zwischen Vollbild und der Schnellstartleiste
umzuschalten. Klicken Sie auf = (Minimieren), um Al Manager in der Taskleiste zu
behalten. Klicken Sie auf = (SchlieBen), um Al Manager zu schlieBen.
Hauptmenii

Das Hauptment enthélt drei Anwendungen: Al Disk, Al Security und Al Booting. Klicken
Sie das kleine Dreieck neben dem Symbol Hauptment, um die Anwendungen im Hauptmentu
einzublenden.
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Al Disk

Al Disk ermdglicht Ihnen das einfache Léschen der temporéren Internetdateien, IE-
URLs, IE-Cookies, |E-Verlaufliste oder Papierkorb. Klicken Sie in der Schnellstartleiste
auf das Symbol Al Disk, um das Hauptfenster des Al Disk anzuzeigen und die
Elemente, die Sie I6schen méchten, auszuwéhlen. Klicken Sie, wenn soweit, auf
Ubernehmen (Apply).

Al Security

Al Security erméglicht lhnen Kennwérter fir Geréte, wie z.B. USB-Laufwerk und CD/
DVD-Laufwerk, einzurichten, und sie vor fremdem Zugriff zu sichern.

So sperren Sie ein Gerat:

1. Wenn Sie Al Security zum ersten Mal benutzen, geben Sie ein Kennwort ein,
welches nicht mehr als 20 Buchstaben, Zahlen oder Zeichen enthdlt.

Bestétigen Sie Ihr Kennwort.
Geben Sie einen Kennworthinweis ein (empfohlen).

Klicken Sie, wenn soweit, auf OK.

A T R A

Wahlen Sie das zu sperrende Gerat und klicken Sie dann auf Ubernehmen
(Apply).

6. Geben Sie das zuvor eingerichtete Kennwort ein und klicken Sie auf OK.
So entsperren Sie ein Gerit:

1. Heben Sie die Auswahl fir das gesperrte Gerét auf und klicken Sie auf
Ubernehmen (Apply).

2. Geben Sie das zuvor eingerichtete Kennwort ein und klicken Sie auf OK.

So dndern Sie das Kennwort:

Klicken Sie auf Kennwort &ndern (Change Password) und folgen Sie den
Bildschirmanweisungen.

Al Booting

Mit Al Booting kénnen Sie die Boot-Gerateprioritat festlegen.
So legen Sie die Boot-Sequenz fest:

1. Wahlen Sie ein Gerat und klicken Sie dann auf die Tasten links/rechts, um die
Boot-Reihenfolge festzulegen.

2. Klicken Sie, wenn soweit, auf Ubernehmen (Apply).
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Meine Favoriten

My Favorites (Meine Favoriten) ermdglicht Ihnen, Anwendungen die Sie 6fter benutzen
hinzuzuftigen, um diese schneller zu finden.

So fligen Sie eine Anwendung hinzu:

1. Klicken Sie auf Hinzufiigen (Add) und wéhlen Sie dann die Anwendung, die Sie
zu Meine Favoriten (My Favorites) hinzufligen wollen.

2. Klicken Sie im Auswahlfenster auf Offnen (Open). Die Anwendung wird zu Meine
Favoriten (My Favorites) hinzugefligt.

Support

Klicken Sie im Fenster Support (Unterstiitzung) auf die Links, um zur ASUS-Webseite,
Webseite fuir technische Untersttitzung, Download-Webseite zu gelangen oder die
Kontaktinformationen abzurufen.

Information

Klicken Sie im Fenster Information auf eine Auswahl, um weitere Informationen lhres
Systems, Motherboards, CPU, BIOS, Speichers und der installierten Geréte anzuzeigen.

Ai Charger

Ai Charger ist eine einzigartige Software Uber die Sie lhre Apple-Gerate (iPod, iPhone, iPad)
am USB 2.0 / USB 3.0-Anschluss Ihres ASUS-Computers aufladen kénnen.

R + Es existiert fir Ai Charger kein Einstellungsbildschirm. Nach der Installation auf Ihren
Computer erscheint das Ai-Charger-Symbol in der Windows®-Taskleiste.

Das Ai-Charger-Symbol ( @, ) zeigt an, wenn ein Apple-Gerét mit dem USB-Anschluss
verbunden ist.

+ Ihr Apple-Gerat kann nur erkannt werden, wenn der richtige Apple-USB-Treiber darin
installiert ist.

/ + Derzeitige Apple-Gerate unterstuitzen nur USB 2.0. Auch wenn Sie Ihr Apple-Gerat

an einen USB 3.0-Anschluss anschlieBen, betrégt der maximale Ladestrom trotzdem
500mA, welcher der maximale USB 2.0-Ladestrom ist. Ai Charger kann dieses Limit auf
bis zu 700mA-900mA erhéhen.

+ Al Charger hat keine speziellen BIOS-, Hardware- oder Chipsatz-Anforderungen.
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ASUS Webstorage

ASUS Webstorage wurde entwickelt, um dabei zu helfen, Ihre Daten auf lhren Laptop, Ihr
Handy oder Tablet-PC zu holen, wo immer Sie eine Internetverbindung haben.

/ Dieses Programm ist bei einigen Modelln schon installiert. Bei Modellen ohne
- Betriebssystem folgen Sie zur Installation den folgenden Schritten.

ASUS Webstorage installieren
So installieren Sie Webstorage:

Legen Sie die Support-DVD in das optische Laufwerk, 6ffnen Sie im Software-Ordner den
Ordner ASUS WebStorage und doppelklicken auf die Datei setup.exe.

Webstorage starten
Starten Sie WebStorage vom Windows®-Desktop durch klicken auf Start > Alle Programme
> ASUS > Webstorage. Es erscheint in der Windows®-Taskleiste das Webstorage-Symbol.

Rechtsklicken Sie auf das Symbol, um

zwischen den Hauptfenster und der Y =
Schnellstartleiste umzuschalten m J_u;:| @Hl O |

© 45US WebStorage

Welcome!

ASUS WebStorage not only provides you the onlinc
backup with highest security standards, but also
utilizes Cloud Computing technology to develop

. diversified applications. Let's explore them all!

MySyncFolder Calendar BookmarkSyncer Mobile App. Go to Web.

Drive

Hier kénnen Sie alle Ihre Sicherungen, synchronisierten Dateien, Kennwort-geschiitzte
Dateien und freigegebene Gruppen beziehen. Rechtsklicken Sie auf die Maus, um eine
Dateivorschau anzuzeigen, bevor Sie die Dateien herunterladen oder eine Freigabe-URL
erzeugen.

Backup

Hier kénnen Sie lhre wichtigsten Daten mittels einfacher Schritte sichern. Stellen Sie einen
Sicherungszeitplan mit lhren Vorgaben im Cloud-Speicher ein oder wahlen Sie “Auto
Backup”, u eine komplette Datensicherung durchzuftihren.

MySyncFolder

Aktualisierte Dateien werden im Ordner MySyncFolder fir einfachen Zugriff gespeichert. Sie
kénnen alle Arten von Dateien ohne die Beschrankung auf Ort oder Gerét freigeben.
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Calendar

ASUS WebStorage synchronisiert die wichtigsten Kalenderereignisse automatisch mit allen PCs.
So verpassen Sie keinen wichtigen Termin, wenn Sie gerade an einen anderen PC arbeiten.

BookmarkSyncer

Der bequeme BookmarkSyncer hélt Ihre Browsereinstellungen und Lesezeichen in der Cloud
und synchronisiert diese automatisch mit den verbundenen Computern.

MobileApp

MobileApp synchronisiert Ihre Dateien zwischen mehreren Geréten. Es unterstitzt auch die
Transcoding-Technologie fiir de Vorschau und Datei-Streaming auf Ihren Handy.

Go to Web

Erleben Sie den wertvollen Cloud-Service tiber ASUS WebStorage ohn das Risiko Daten zu
verlieren.

Einstellungen

1. Kicken Sie auf das Symbol Settings E, um das Einstellungsfenster zu 6ffnen.

2. Folgen Sie den Bildschirmanweisungen, um die Konfiguration abzuschlieBen.

[z Settings X

Language

Select yous prefered language: | English -

Upload speed setting
Set ASUS WebStorage uplo:

Low '—l"_gh
Proxy Settings
Set up a proxy te connect te the network (O Tumon (s) Tumeoff
HTTP Proxy Port
Account Name : Password :

Apply
V3.094193
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ASUS Easy Update

ASUS Easy Update ist ein Programm welches automatisch nach den neuseten treibern und
Anwendungen flir Ihr System sucht.

1.

128

Doppelklicken Sie in der Windows ©-
Taskleiste auf das Symbol ASUS Easy s |'i' 1 15 'i':=| [ b)
Update icon. =

Wihlen Sie Schedule, um einzustellen, N"_"E

wie oft Sie Ihr System aktualisieren Daily

wollen. Every third day

Wahlen Sie Update, um die v Weekly

Aktualisierung zu aktivieren. Every second week
Monthly

Every third month

Klicken Sie auf OK, um die Elemente
anzuzeigen, die Sie herunterladen
kénnen.

PXP5M1-DHS
[

en_ Werson FilsSe (KB
@ voLr-a7osFzaEe

t P ———

Markieren Sie die Elemente, die Sie
herunterladen wollen und klicken Sie . L s _
dann auf OK. . [ astio p22 [T —

e Version Fie Se (3]
B F0s

IE:

) Apicetion
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ASUS Instant On

Mit ASUS Instant On haben Sie schnellen Zugriff auf den Hybrid-Schlafmodus.

ASUS Instant On verwenden
So verwenden Sie ASUS Instant On:
Das Instant On-Programm ist vorinstalliert und wird beim Start

des Computers automatisch ausgefuhrt. & @

1. Sie sehen das Programmsymbol in der Windows-
Taskleiste, wenn Sie Ihren Computer hochgefahren haben.

Customize...

2. Drticken Sie die tasten <Alt + F1> und
dann in der Bestatigungsmeldung auf
OK. Ihr System wird in den Hybrid-
Schlafmodus versetzt.

% Die Standard-Tastenkombination

a ist <Alt + F1>. Um diese zu dndern
beziehen Sie sich bitte auf den
nachsten Abschnitt.

Markieren, um diese Nachricht nicht wieder
anzuzeigen.

ASUS Instant On einrichten
So richten Sie ASUS Instant On ein:

1. Rechtsklicken Sie in der Windows-
Taskleiste auf das ASUS Instant

Fa
On-Symbol , um das
Haupteinstellungsfenster zu 6ffnen.

Sie kénnen die tastenkombination ftir
ASUS Instant On aktivieren/deaktivieren
und ASUS Instant On-Symbol anzeigen/
ausblenden auswahlen.

2. Klicken Sie im Hauptfenster auf
Neu definieren, um das Hotkey-
Einstellungsfenster zu éffnen.

3.  Geben Sie de Tastenkombination ein, AT+ FL
die Sie ftir ASUS Instant On verwenden
wollen.

4. Klicken Sie auf OK, um die Anderungen
zu speichern oder auf Abbrechen, um
diese zu verwerfen.
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Nero 9

Nero 9 ermdglicht Ihnen das Erstellen, Kopieren, Brennen, Bearbeiten, Freigeben und
Aktualisieren von Daten verschiedenen Typs.

Nero 9 installieren
So installieren Sie Nero 9:

1. Legen Sie die Nero 9 DVD in das optisches Laufwerk ein.
2. Falls Autorun aktiviert ist, erscheint automatisch das Hauptmenti.

Falls Autorun deaktiviert ist, doppelklicken Sie die Datei SeupX.exe im Hauptverzeichnis
Ihrer Nero 9 DVD.

Klicken Sie im Hauptment auf Nero 9 Essentials.

4. Wdhlen Sie die gewtinschte Sprache fir den Installationsassistenten. Klicken Sie auf
Weiter (Next).

5. Klicken Sie auf Weiter (Next), um fortzufahren.

6.  Wabhlen Sie Ich akzeptiere die Lizenzbedingungen (I accept the License
Conditions). Wenn soweit, klicken Sie auf Weiter (Next).

7. Wabhlen Sie Typisch (Typical) und klicken Sie dann auf Weiter (Next).

Wéhlen Sie Ja, ich méchte Anwendungsdaten anonym an Nero senden (Yes, |
want to help by sending anonymous application data to Nero) und klicken Sie
Weiter (Next).

9. Wenn abgeschlossen, klicken Sie auf Beenden (Exit).

Dateien brennen

So brennen Sie Dateien:

1. Klicken Sie im Hauptment auf Daten brennen (Data Burning) > Hinzufiigen (Add).

2. Wabhlen Sie die Dateien, die Sie brennen méchten. Wenn soweit, klicken Sie auf
Hinzufiigen (Add).

3. Nachdem Sie die Dateien zum Brennen ausgewdhlet haben, klicken Sie auf Brennen
(Burn), um die Dateien auf einen Datentrdger zu brennen.

Fir weitere Details zur Verwendung von Nero 9, beziehen Sie sich auf die Nero Webseite
unter www.nero.com.
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Systemwiederherstellung

Verwenden der Wiederherstellungspartition

Die Wiederherstellungspartition versetzt die Software Ihres Desktop PCs schnell in ihren
originalen Betriebszustand zurtick. Bevor Sie die Wiederherstellungspartition benutzen,
kopieren Sie Ihre persénlichen Dateien (z.B. Outlook PST-Dateien) auf einem USB-
Datentrdger oder Netzwerklaufwerk und notieren Sie sich Benutzereinstellungen (z.B.
Netzwerkeinstellungen).

Uber die Wiederherstellungspartition

Die Wiederherstellungspartition ist reservierter Speicherplatz auf der Festplatte. Diese
Partition wird benutzt, um das Betriebssystem, die Treiber und die vom Hersteller installierten
Programme lhres Desktop PC wiederherzustellen.

R Ldschen Sie NICHT die Partition

mit dem Namen RECOVERY. Die
Wiederherstellungspartition wurde
werkseitig erstellt und kann, wenn
vom Benutzer geléscht, NICHT wieder
hergestellt werden. Bringen Sie Ihr
Desktop PC zum ASUS Kundendienst,
wenn Sie mit der Wiederherstellung
Probleme haben.

i iV bt
«+2DEMDBXFSa8

Verwenden der Wiederherstellungspartition:
1. Drlcken Sie wahrend des Starvorgangs <F9>
2. Driicken Sie die <Eingabetaste>, um Windows Setup [EMS Enabled] zu wéhlen.
3. Wahlen Sie eine der folgenden Wiederherstellungsoptionen.
Systemwiederherstellung (System Recovery):
Diese Funktion stellt die Werkseinstellungen wieder her.

Systemabbildsicherung (System Image Backup):

Diese Funktion erméglicht das Brennen von Systemabbildern auf DVDs, um das
System spéter auf seine Standardeinstellungen wiederherzustellen.

System DVD-Sicherung (System DVD Backup):
Diese Funktion erstellt eine Sicherungskopie der Support-DVD.

4. Folgen Sie den Bildschirmanweisungen, um den Wiederherstellungsprozess
abzuschlieBen.

/ Fur aktuelle Treiber und Anwendungen besuchen Sie die ASUS-Webseite unter
Www.asus.com.
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Wiederherstellungs-DVD verwenden (nur bei bestimmten Modellen)

% Bereiten Sie 1~3 leere und beschreibbare DVDs fiir de Erstellung der Wiederherstellungs-
DVD vor.

R Entfernen Sie die externe Festplatte bevor Sie die Systemwiederherstellung durchfihren.
Laut Microsoft kénnen Sie wichtige Daten verlieren, wenn Sie Windows Vista auf der
falschen Festplatte installieren oder die falsche Partition formatieren.

Verwenden der Wiederherstellungs-DVD:

1. Legen Sie die Wiederherstellungs-DVD in das optische Laufwerk. Ihr Desktop PC
muss eingeschaltet sein.

2. Starten Sie den Desktop PC neu und driicken Sie beim Boot-Vorgang auf die Taste
<F8> und wéhlen Sie das optische Laufwerk (eventuell als “CD/DVD” bezeichnet).
Driicken Sie die <Eingabetaste>, um von der Wiederherstellungs-DVD zu booten.

Wahlen OK, um die Wiederherstellung des Abbild (Image) zu starten:

4. Wahlen OK, um die Systemwiederherstellung zu bestatigen.

R Die Wiederherstellung tberschreibt alle Daten in Ihrer Festplatte. Vergewissern Sie sich,
dass Sie wichtige Daten gesichert haben, bevor Sie den Vorgang ausfuhren.

5. Folgen Sie die Bildschirmanweisungen, um den Wiederherstellungsvorgang
abzuschlieBen.

) ! Entfernen Sie wéahrend des Wiederherstellungs-vorgangs NICHT die Wiederherstellungs-
DVD bevor Sie dazu aufgefordert werden, sonst wird die Partition unbrauchbar.

/ Fur aktuelle Treiber und Anwendungen besuchen Sie die ASUS-Webseite unter
WWWw.asus.com.
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Problembehandiung

Problembehandlung
Diese Kapitel stellt einige Probleme vor, mit denen Sie konfrontiert werden kénnten und bietet
einige Ldsungsansatze.

?  Mein Computer kann nicht eingeschaltet werden und die Betriebs-
LED auf der Vorderseite leuchtet nicht.

. Priifen Sie, ob Ihr Computer richtig angeschlossen ist.
. Prifen Sie, ob die (Strom)Steckdose betriebsbereit ist.

Priifen Sie, ob das Netzteil eingeschaltet ist. Beziehen Sie sich auf den
Abschnitt Ein-/Ausschalten Ihres Computers in Kapitel 1.

?  Mein Computer héngt.
. Versuchen Sie folgendes, um Programme, die nicht reagieren, zu schlieBen:

1. Drticken Sie gleichzeitig auf die Tastaturtasten <Alt> + <Strg> + <Entf>
und dann auf Task-Manager starten (Start Task Manger).

2. Klicken Sie auf die Auswahl Anwendungen (Applications).

3. Waéhlen Sie das nicht reagierende Programm und klicken Sie auf Task
beenden (End Task).

. Falls die Tastatur nicht reagiert, driicken und halten Sie die Einschalttaste, bis
der Computer sich ausschaltet. Driicken Sie erneut auf die Einschalttaste, um
ihn wieder zu starten.

?  Ich kann mich mit der ASUS WLAN-Karte nicht mit dem Drahtlos-
Netzwerk verbinden (nur an bestimmten Modellen)?

. Stellen Sie sicher, dass Sie flir das gewtinschte Netzwerk den richtigen
Netzwerkschltissel eingegeben haben.

. Verbinden Sie externe Antennen (wahlweise) mit den Antennenanschllissen
der ASUS WLAN-Karte und stellen Sie die Antennen auf die Oberseite lhres
Computer-Gehduses, um die beste drahtlose Netzwerkleistung zu erzielen.

72  Die Pfeiltasten auf der Zahlentastatur funktionieren nicht.

Priifen Sie, ob die Zahlensperre- (NUM)-LED ausgeschaltet ist. Falls die
NUM-LED an ist, werden die Tasten auf der Zahlentastatur nur fur die
Zahleneingabe genutzt. Falls Sie die Tasten auf der Zahlentastatur verwenden
mdchten, driicken Sie die Taste NUM, um die NUM-LED auszuschalten.
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?  Keine Anzeige auf dem Monotor.

Prifen Sie, ob der Monitor eingeschaltet ist.

Prifen Sie, ob der Monitor richtig mit dem Videoausgang lhres Computers
verbunden ist.

. Falls Ihr Computer eine aufgesetzte Grafikkarte aufweist, sollten Sie den
Monitor mit dem Videoausgang der aufgesetzten Karte verbinden.

Prufen Sie, dass keine Pole am Videostecker verbogen sind. Falls Sie
verbogene Pole entdecken, ersetzen Sie das Videoverbindungskabel fiir den
Monitor.

Prifen Sie, dass |hr Monitor richtig mit der Stromversorgung verbunden ist.

Fur weitere Informationen und erweiterte Problembehandlung, beziehen Sie
sich auf die mit dem Monitor mitgelieferte Dokumentation.

?  Beim Verwenden von zwei Monitoren liefert nur einer eine Anzeige.

Stellen Sie sicher, dass die beiden Monitore eingeschaltet sind.

Waéhrend des POST hat nur der mit dem VGA-Anschluss verbundene Monitor
eine Anzeige. Die Dual-Anzeige funktioniert nur in der Windows-Umgebung.

Falls eine Grafikkarte auf lnrem Computer installiert ist, sollten die Monitore
mit den Ausgéngen der Grafikkarte verbunden sein.

. Prifen Sie, ob die Einstellungen fiir mehrere Anzeigegeréte korrekt sind. Fur
Details beziehen Sie sich auf den Abschnitt AnschlieBen von mehreren
externen Anzeigegeréten in Kapital 3.

?  Mein Computer kann meinen USB-Datentréger nicht erkennen.

Beim ersten Verbinden eines USB-Datentrégers mit lhrem Computer installiert
Windows automatisch einen entsprechenden Treiber fir das Gerat. Warten
Sie einen Moment und prifen Sie am Arbeitsplatz (My Computer), ob ein
USB-Datentréger erkannt wurde.

Verbinden Sie den USB-Datentrdger mit einem anderen Computer um zu
prifen, ob der USB-Datentrdger defekt ist oder eine Fehlfunktion aufweist.

?  Ich méchte die Systemeinstellungen meines Computers
wiederherstellen oder riickgdngig machen, ohne meine persénlichen
Dateien oder Daten zu beeinflussen.

Die Funktion Windows® Systemwiederherstellung erméglicht Ihnen die
Wiederherstellung oder das Rtickgangigmachen der Systemeinstellungen
Ihres Computers, ohne Einfluss auf Ihre personlichen Daten wie Dokumente
oder Fotos. Fur weitere Details beziehen Sie sich auf den Abschnitt System
wiederherstellen in Kapitel 2.
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?  Das HDTV-Bild ist gestreckt.

Dies wird durch unterschiedliche Auflésungen lhres Monitors und HDTVs
verursacht. Passen Sie die Bildschirmaufiésung lhres HDTVs an. So &ndern
Sie die Bildschirmauflésung:

1. Folgen Sie einer Vorgehensweise, um das Einstellungsfenster
Bildschirmauflésung (Screen Resolution) aufzurufen:

+ Klicken Sie auf ¥ > Systemsteuerung (Control Panel) > Darstellung
und Anpassung (Appearance and Personalization) > Anzeige
(Display) > Anzeigeeinstellungen Andern (Change display settings).

+ Klicken Sie mit der rechten Maustaste irgendwo im Desktop. Wéhlen
Sie im Kontextmenu Anpassen (Personalize) > Anzeige (Display) >
Anzeigeeinstellungen dndern (Change display settings).

2. Passen Sie die Auflésung an. Fur die richtige Auflésung beziehen Sie auf
die Dokumentation Ihres HDTVs.

3. Klicken Sie auf Ubernehmen (Apply) oder auf OK und in der
Bestdtigungsnachricht dann auf Anderungen beibehalten
(Keep Changes).

?  Meine Lautsprecher geben keinen Sound ab.

Stellen Sie sicher, dass die Lautsprecher mit dem Line-Out-Anschluss
(Hellgrain) auf der Vorderseite oder Rtickseite verbunden sind.

Priifen Sie, ob die Lautsprecher an die Stromversorgung angeschlossen und
eingeschalten sind.

. Passen Sie die Lautstérke Ihrer Lautsprecher an.

Stellen Sie sicher, dass die Lautstédrke des Systems nicht stummgeschaltet ist.
+  Falls stummgeschaltet, erscheint das Lautstérkesymbol als .Um
Lautstdrke zu aktivieren, klicken Sie im Infobereich des Windows auf
und dann auf % .

Falls nicht stummgeschaltet, klicken Sie auf m und schieben Sie den
Regler, um die Lautstérke anzupassen.

. Um zu priifen, ob die Lautsprecher sachgemaB funktionieren, verbinden Sie
die Lautsprecher mit einem anderen Computer.
?  Das DVD-Laufwerk kann den Datentréger nicht lesen.

. Prifen Sie, ob der Datentréger mit der bedruckten Seite nach oben eingelegt ist.

Priifen Sie, ob der Datentréger in der Mitte des Laufwerkfachs ausgerichtet
ist, insbesondere bei Datentrdgern anderer GréBen oder Formen.

. Prifen Sie, ob der Datentréger zerkratzt oder beschddigt ist.

?  Der Auswurfsknopf des DVD-Laufwerks reagiert nicht.

1. Klicken Sie auf ¢ > Arbeitsplatz (Computer).

) o ) DVD-RW-Laufwerk (D:)
2. Klicken Sie mit der rechten Maustaste auf f-}-$ , dann
auf Auswerfen (Eject) im Kontextment.
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Stromversorgung

Problem Mégliche Ursachen

Falsche Betriebsspannung.

MaBnahmen

+ Passen Sie den Betriebsspannungs-
schalter lhres Computers je nach
den Anforderungen Ihrer Region an.

+ Passen Sie die Spannungs-
einstellungen an. Vergessen Sie
nicht, den Stromkabel aus der
Steckdose zu ziehen.

Kein Strom Ihr Computer ist nicht
(Die Betriebs- eingeschaltet.

Driicken Sie den Einschaltknopf auf
der Vorderseite Ihres Computers, um
ihn einzuschalten.

anzeige ist aus)

Das Stromkabel Ihres
Computers ist nicht richtig
angeschlossen.

+ Stellen sie sicher, dass das
Stromkabel sachgeméB
angeschlossen ist.

+ Verwenden Sie ein anderes
passendes Stromkabel.

Probleme mit dem Netzteil
(PSU; Power supply unit).

Versuchen Sie ein anderes Netzteil
anzuschlieBen.

MaBnahmen

+ Verbinden Sie das Signalkabel mit
dem richtigen Anschluss f(r die
Anzeige (Anschluss der integrierten
VGA oder aufgesetzten VGA).

+ Wenn Sie eine aufgesetzte VGA
verwenden, verbinden Sie das
Signalkabel mit dem Anschluss der
aufgesetzten VGA.

Anzeige
Problem Mégliche Ursachen
Keine Anzeige, Das Signalkabel ist
nachdem der nicht mit dem richtigen
Computer VGA-Anschluss lhres
eingeschaltet Computers verbunden.
wurde
(Schwarzes
Bildschirm).
Probleme mit dem
Signalkabel.

Versuchen Sie einen anderen
Bildschirm anzuschlieBen.
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LAN

Problem

Kein Internet

Mégliche Ursachen

Das LAN-Kabel ist nicht
angeschlossen.

MaBnahmen

Verbinden Sie das LAN-Kabel mit
Ihrem Computer.

Probleme mit dem LAN-
Kabel.

Die LAN LED sollte an sein,
Andernfalls probieren Sie ein anderes
LAN-Kabel. Falls das Problem weiter
besteht, kontaktieren Sie den ASUS
Kundendienst.

Ihr Computer ist nicht
sachgemdB mit den Router
oder Hub verbunden.

Stellen Sie sicher, dass Ihr Computer
sachgemdB mit den Router oder Hub
verbunden ist.

Netzwerkeinstellungen

Fur korrekte LAN-Einstellungen
setzen Sie sich mit Inrem Internet
Dienstanbieter (ISP) in Verbindung.

Durch Antivirus Software
verursachte Probleme.

SchlieBen Sie die Antivirus Software.

Probleme mit Treibern.

Reinstallieren Sie die LAN-Treiber.

Audio
Problem Mdgliche Ursachen MaBnahmen
+ Beziehen Sie sich fur die richtigen
Lautsprecher oder Anschlusspositionen auf das
Kopfhérer sind nicht richtig Benutzerhandbuch.
angeschlossen. + Trennen und Verbinden Sie den
Lautsprecher mit lhrem Computer.
Lautsprecher oder Versuchen Sie einen anderen
. ) Kopfhérer funktionieren Lautsprecher oder Kopfhérer zu
Kein Audio nicht sachgemas. verwenden.
. " Prifen Sie alle Audio-Anschllisse
Die Anschiisse (I%uchsgn) (Buchsen) auf der Vorder-/Ruickseite.
auf der Vorder-/Riickseite . . .
- . Falls ein Anschluss nicht funktioniert,
funktionieren nicht » . . )
. prifen Sie, ob dieser zu Multi-Kanal
sachgeméB. .
gesetzt ist.
Probleme mit Treibern. Reinstallieren Sie die Audio-Treiber.
ASUS CM6870
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System

Problem

Systemgeschwin-
digkeit zu gering.

Mégliche Ursachen

Es werden zu viele
Programme ausgeftihrt.

MaBnahmen

SchlieBen Sie einige Programme.

Computervirusattacke

Verwenden Sie ein
Antivirusprogramm, um lhren
Computer nach Viren zu prifen
und zu reparieren.
Reinstallieren Sie das
Betriebssystem

Das System
bleibt 6fters
héngen oder
reagiert nicht.

Betriebsausfall des
Festplattenlaufwerks.

Senden Sie das beschédigte
Festplattenlaufwerk zur reparatur
an den ASUS Kundendienst.
Ersetzen Sie es durch ein neues
Festplattenlaufwerk.

Probleme mit
Speichermodulen.

Ersetzen Sie diese mit passenden
(kompatiblen) Speichermodulen.
Entfernen Sie die nachtrdglich
eingebauten Speichermodule und
versuchen Sie es erneut.

Der Luftstrom zur Kiihlung
lhres Computers ist
unzureichend.

Stellen Sie den Computer an einem
Platz mit besserer Luftzirkulation auf.

Inkompatible Software
wurde installiert.

Reinstallieren Sie das
Betriebssystem und reinstallieren Sie
kompatible Software.
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CPU

Problem

Hoher Gerdusch-
pegel nach
Computerstart.

Méglich